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ABSTRACT 

Today’s college students are often labeled the “Net Generation” and assumed to be 

computer savvy and technological minded. Exposure to and use of technologies can increase 

self-efficacy regarding ability to complete desired computer tasks, but students arrive on 

campuses unable to pass computer proficiency exams. This is concerning because some colleges 

and universities have eliminated introductory computer courses following the 120-Hour Rule. 

This study’s purpose was to investigate relationships between computer self-efficacy and 

computer proficiency and to determine whether students are prepared for technological demands 

of college. 

Quantitative data were collected from pre- and postcourse surveys and pre- and 

postcourse proficiency exams. Participants included students enrolled in introductory computer 

courses at one university. Courses used the competency based training product, SimNet for 

Office 2007, to train and assess students. Results indicated general computer self-efficacy 

(GCSE) ratings were highest for students that had taken three or more computer classes in high 

school. GCSE was higher than task-specific computer self-efficacy (TSCE) for Excel and Access 

applications, but lower than TSCE for the Vista operating system and Word. TCSE was found to 

be higher than performance scores for Vista, Access, Excel, PPT, and Word. Completing an 

introductory computer class was found to increase computer self-efficacy ratings and computer 

proficiency scores.  
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Results suggested that many students are not proficient in Office 2007 applications 

needed in college. Colleges and universities need to assess computer proficiency of incoming 

students and train them in the computer skills needed to be successful in college and beyond. 
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CHAPTER 1 
 

INTRODUCTION 

Colleges and universities face the daunting task of assessing the computer proficiency of 

incoming students and training them in the computer skills they will need to be successful in 

college and beyond. Skill knowledge involving word processing, spreadsheets, databases, 

presentation software, emailing, internet, and other basic computer concepts are the fundamental 

computer skills used in academia as well as in industry (Hardy, 2005; Hulick & Valentine, 2008; 

Wilkinson, 2006; Wolk, 2008). The widespread assumption that individuals raised in this “digital 

world” possess adequate computing skills to be successful in entry-level college courses is 

unsubstantiated (Hulick & Valentine, 2008; Wallace & Clariana, 2005). Although computer use 

is likely to increase one’s self-efficacy when it comes to completing computing tasks (Hill, 

Smith, & Mann, 1987), numerous studies have concluded that many students are not computer 

proficient upon entering college (Coolbaugh, 2004; Hardy, 2005; Hulick & Valentine, 2008; 

Rafaill & Peach, 2001; Shannon, 2008; Templeton, Jones, &  Li., 2003; VanLengen, 2007; 

Wallace & Clariana, 2005). Assessing relationships between students’ task-specific computer 

self-efficacy and task-based computer proficiency is the focus of this study.  

The youth of Generation Y are being raised in a culture immersed in technology. Similar 

to the way television influenced the culture and values of the baby boomer generation, 

computers, cell phones, video games, music players, social networking sites, and search engines 

are shaping the values and culture of this generation (Tapscott, 1998). Generation Y, also 

referred to as the Net Generation (Tapscott, 1998), Millennial Generation (Howe & Strauss, 
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2000), Music Television (MTV) generation, Nexters, and the I.P.O.D.ers (Akande, 2008), are 

identified as individuals born after 1980 (Akande, 2008; Bennett, Maton, & Kervin, 2008) and 

account for the largest and most diverse group of learners in our nation’s history (U.S. 

Department of Education, 2004). The multitasking youth of this generation have reported that 

they often spend up to a fourth of their day engaged in technology activities (Giles & Price, 

2008; Hulick & Valentine, 2008; Tapscott, 1998). Because they spend a large amount of time 

engaged in computer use, when surveyed, these generational youths rate themselves high when it 

comes to confidence regarding their computer skills and abilities (Considine, Horton, & 

Moorman, 2009; Imhof, Vollmeyer, & Beierlien, 2007; Lahore, 2008; Wilkinson, 2006). 

Students with higher levels of computer self-efficacy may view introductory computer 

applications classes as being easy and may not exert the necessary effort to learn the computer 

skills and concepts taught in such classes (Smith, 2001). 

This past year more than 2 million Generation Y high school graduates enrolled in 

college (U. S. Bureau of Labor Statistics, 2007). It would be easy to presuppose that these 

“techno-savvy” youth would arrive on campus with the basic computer skills needed to be 

successful in entry-level course work. After all, technology standards involving basic computer 

concepts, word processing, spreadsheets, databases, and presentation software are a common 

element of the technology course of study in high schools across the nation (NETS, 2007). 

However, although 99% of high schools offer computer literacy courses, only 13% of high 

schools require a computer literacy course for graduation, and only two states (Nevada and North 

Carolina) have a computer literacy graduation exam requirement (Ceccucci, 2006). Hardy (2005) 

reported that students at the college level need basic computer application skills in order to 

function at the postsecondary level of learning. Although studies have concluded that these skills 
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are necessary for postsecondary education, only a small percentage of college students are 

passing computer skills proficiency exams offered by colleges and universities (Coolbaugh, 

2004; Hardy, 2005; Hulick & Valentine, 2008; Rafaill & Peach, 2001; Shannon, 2008; 

Templeton et al., 2003; VanLengen, 2007; Wallace & Clariana, 2005). This is cause for concern, 

because many colleges and universities are amending curricula to remove introductory computer 

courses from their baccalaureate degree programs. Removal of introductory computer courses is 

partly due to the nationwide push by state legislatures to reduce degree programs to 120 degree 

credit hours (Shannon, 2008; THECB, 2009), as well as the theory that there is no longer a need 

for such courses (Hulick & Valentine, 2008). In 2001, Rafaill and Peach predicted that in a few 

short years, introductory computer courses would not be necessary. However, a review of 

proficiency studies by Hulick and Valentine (2008) consistently found that college students did 

not possess the basic computer applications skills needed to be successful in college. Hulick and 

Valentine concluded their study by recommending that college students be required to take a 

formal course in computer applications or take a proficiency exam to demonstrate mastery of 

skills. Smith (2001) suggested that task-specific computer self-efficacy (TCSE) assessments be 

used along with proficiency exams and/or introductory classes to fully assess the strengths, 

weaknesses, and training needs of students. 

Statement of the Problem 

Research has documented the importance of college-bound individuals possessing basic 

computer skills related to word processing, spreadsheets, presentation software, and computer 

concepts (Hardy, 2005; Hulick & Valentine, 2008; Wilkinson, 2006; Wolk, 2008). Research also 

indicates that although students should be exposed to and taught these skills during their high 

school years, computer courses in high school are often only offered as elective courses 
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(Ceccucci, 2006). Based on proficiency testing scores, the majority of entering college students 

are not passing skill-based computer literacy exams (Coolbaugh, 2004; Hardy, 2005; Hulick & 

Valentine, 2008; Rafaill & Peach, 2001; Shannon, 2008; Templeton et al., 2003; VanLengen, 

2007; Wallace & Clariana, 2005), although they appear to be self-confident regarding their 

computer skills. Students entering college and not exhibiting the necessary basic computer skills 

should enroll in an introductory computing course to acquire those skills that will assist them in 

being successful in entry-level college offerings (Hulick & Valentine, 2008; Shannon, 2008), but 

the future of such class offerings at many colleges is in jeopardy (Hulick & Valentine, 2008; 

Shannon, 2008; Wallace & Clariana, 2005). 

Some campuses continue to offer introductory computer courses due to growing campus 

enrollments, computer literacy requirements, and elective offerings. It is important for these 

colleges and universities to provide research-based computer proficiency assessments, to be 

aware of what students already know upon entering college, and to offer individualized 

instruction or remediation to students lacking needed computer skills. It is also important to 

assess students’ computer self-efficacy, because it may have a relationship with computer task 

performance (Smith, 2001). 

This study took place at a large university in the Southeast that is experiencing these 

same types of challenges. The enrollment in the university’s introductory computer skills course, 

referred to in this document as CS102, is growing as campus enrollment increases. The course is 

attempting to service more students, therefore, facilitating the course is utilizing more faculty 

resources. In the fall of 2007, the university adopted McGraw-Hill’s web-based training and 

assessment product titled, SimNet Online for Office 2007. SimNet Online for Office 2007 allows 

the university to (1) proficiency test students who elect to take the assessment in an attempt to 
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place out of CS102 (meaning the student does not have to take the course and may move on to 

the next class); (2) pre- and posttest students that enroll in CS102; and (3) custom design lessons 

for students taking CS102 to provide training and practice for skills not mastered as determined 

by the pretests and practice exams. 

Statement of Purpose 

The purpose of this study was to explore the relationship between task-specific computer 

self-efficacy (TCSE) and computer proficiency regarding completion of tasks using the Vista 

operating system and Office 2007 applications Access, Excel, PowerPoint (PPT), and Word. 

Self-efficacy theory (SET) states that self-efficacy is a reliable indicator of performance 

(Bandura,1977), however recent research assessing computer self-efficacy and computer 

performance has found that computer self-efficacy ratings are often higher than performance 

scores ( Grant, Malloy, & Murphy, 2009 ; Shannon, 2008;  Smith, 2001). This study also 

examined whether students enrolling in the introductory course (CS102) were already computer 

proficient. Additionally, this study sought to determine whether computer self-efficacy and 

performance increased after completing an introductory college-level computer course, and 

whether data indicate that there is still a need to offer introductory computer courses at the 

college level.  

Significance of the Problem 

This study is significant because there is a growing interest and need for empirical studies 

regarding computer self-efficacy and computer performance especially as it pertains to 

proficiency testing at the postsecondary level. Many colleges and universities are eliminating 

introductory computer course requirements in favor of moving to a required computer 

proficiency exam. However, studies report that a large number students are coming to college 
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without the necessary computer applications skills they need to be successful in college and are 

not passing computer proficiency exams (Coolbaugh, 2004; Hardy, 2005: Hulick & Valentine, 

2008; Rafaill & Peach, 2001; Shannon, 2008; Templeton et al., 2003; VanLengen, 2007; Wallace 

& Clariana, 2005) despite students indicating high levels of computer self-efficacy (Grant et al., 

2009; Shannon, 2008; Smith, 2001). Findings from this study add to the general literature base 

on the topics of basic computer proficiency skills needed by college students, computer self-

efficacy and computer proficiency, as well as computer proficiency assessments and training. 

Additionally, the study contributes data to the current debate regarding the need for introductory 

computer courses and/or proficiency testing at the postsecondary level. 

Research Questions 

1. Are general computer self-efficacy (GCSE) ratings higher than task-specific 

computer efficacy (TCSE) ratings? 

2. Is there a relationship between the number of computer classes taken in high school 

and task-specific computer self-efficacy (TCSE) regarding completing computer tasks 

using Vista and Microsoft Office 2007 applications Access, Excel, PowerPoint, and 

Word? 

3. Is there a relationship between task-specific computer self-efficacy (TCSE) and 

computer proficiency regarding completing computer tasks using Vista and Microsoft 

Office 2007 applications Access, Excel, PowerPoint, and Word? 

4. Does task-specific computer self-efficacy (TCSE) regarding completing computer 

tasks using Vista and Microsoft Office 2007 applications Access, Excel, PowerPoint, 

and Word increase after completing an introductory computer class? 
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5. Does computer proficiency regarding completing computer tasks using Vista and 

Microsoft Office 2007 applications Access, Excel, PowerPoint, and Word increase 

after completing an introductory computer class? 

Assumptions of the Study 

The following assumptions exist in regard to this study: 

1. Survey questions regarding student demographics, prior computer use, and training 

were appropriate and relate to this study. 

2. Survey respondents’ answers were truthful. 

3. Proficiency exam questions were relevant to the computer skills needed in college 

courses across campus. 

4. Students completed all components of study, including both surveys and the 

proficiency test (pretest and posttest). 

Limitations of the Study 

The following indicates identifiable limitations to guide the interpretation of this study: 

1. The study was limited to multiple sections of one course, at one university. 

2. The pre- and postcourse surveys were original surveys designed according to specific 

course curriculum and proficiency definitions of one introductory computer course at 

one university. 

3. All participants did not complete all pre- and postcourse proficiency exams, so 

pairwise numbers are not equal across topic areas. 

4. Only one type of training and assessment, which was a competency-based training 

product, was used in the courses for this study. Alternate methods of instruction and 

assessment may have produced other results. 
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5. Students previously trained in Office 2003 applications may have overrated their 

ability to complete tasks using Office 2007 software. The user interface of Office 

2007 is quite different from that of Office 2003. New learning needs to take place in 

the transition from Office 2003 to Office 2007, and some participants may not have 

been aware of the differences. 

Definition of Terms 

Computer Proficiency. The dictionary.com definition of the word proficiency means “the 

state of being proficient, skill; expertness.” The passing computer proficiency exam score varies 

depending on the college or university administering the exam. For the purpose of this study, the 

passing proficiency score was 75% in each subdomain tested. This scoring scale was partly 

determined by the fact that students with majors requiring CS102 must pass the course with a 

“C” average. 

Computer self-efficacy. Judgment of one’s ability or effectiveness using a computer 

(Compeau & Higgins 1995). 

General computer self-efficacy (GCSE). Assessment of an individual’s CSE for all 

computing domains (Downey & McMurtrey, 2007; Marakas et al., 1998; Stephens, 2006). 

Introductory computer course. Micro-computer applications course that is traditionally 

the first computer course taken at the college level. The purpose of the class is to provide basic 

computer literacy in the areas of computer applications important for success at the college level. 

Self-efficacy (SE). Judgment of one’s ability or effectiveness to produce a desired result 

(Bandura, 1977, 1982, 1986). 

Task-specific computer self-efficacy (TSCS). This refers to one’s belief in how well 

he/she can use a computer to complete specified tasks within the domain of general computing 
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(Marakas, Yi, & Johnson, 1998). In this study, the term is used to refer to one’s belief in how 

well he/she can use a computer to complete specified tasks using the Vista operating system and 

basic Microsoft Office 2007 applications Access, Excel, PowerPoint, and Word. The term is use 

d interchangeably with specific computer self-efficacy (TCSE).Training – instruction involving 

how to complete application based tasks using a computer and the actual repeated practice of 

completing such tasks using a computer 

Organization of the Study 

This study is organized into five chapters. Chapter 1 includes an introduction to the study 

by providing a brief background of the problem being studied. Chapter 1 also contains a 

statement of purpose, the significance of the study, research questions, assumptions, and 

limitations of the study. Chapter 2 offers a review of the literature that provides the background 

for this study. Chapter 3 gives an explanation of the methods used to implement the study, 

including an introduction, setting, participants involved, instrumentation used, data collection, 

and data analysis. Chapter 4 provides the results of the study, and Chapter 5 contains a 

discussion of the findings and the resulting conclusions and recommendations for future studies. 
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CHAPTER 2 

REVIEW OF LITERATURE 

Introduction 

Using technology is a daily occurrence for the youth of Generation Y. They were born 

during the information age and have grown and developed along with the Internet. Smart-

phones, i-Pods, the Web, online gaming, and social networking sites are staples in their 

environment. The ease of access to and the daily use of technology generate a confidence level in 

these young persons in regard to their beliefs as to whether they can complete other computing 

tasks or not (Considine et al., 2009; Imhof, Vollmeyer, Beierlien, 2007; Wilkinson, 2006). 

Judgment of capability to perform a given task is called self-efficacy (SE; Bandura, 1977, 1982, 

1986), and when the judgment pertains to one’s ability to complete a task using a computer it is 

called computer self-efficacy (CSE; Compeau & Higgins, 1995). 

Self-efficacy theory stems from social cognitive theory (Bandura, 1977, 1982, 1986). 

Social cognitive theory suggests that behavior, cognition, and the environment exist in a shared 

relationship working together to assist in one being able to generate self-appraisals of capability. 

Although research has attained that self-efficacy is a valid predictor of performance (Marakas et 

al., 1998), recent research shows a trend of Generation Y students arriving on campus with high 

levels of computer self-efficacy (Considine et al., 2009; Imhof et al., 2007; Lahore, 2008; 

Shannon, 2008; Wilkinson, 2006), but they are unable to pass basic computer proficiency 

assessments (Coolbaugh, 2004; Hardy, 2005; Hulick & Valentine, 2008; Rafaill & Peach, 2001; 

Shannon, 2008; Templeton et al., 2003; VanLengen, 2007; Wallace & Clariana, 2005). This may 
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be a result of heightened general computer self-efficacy levels or it may be a result of a lack of 

technology training.  

Although opportunities to learn and use technology have increased in elementary and 

secondary schools (Stephens, 2006), differences exist when it comes to mandatory technology 

training in our nation’s secondary schools. An additional problem is that instructors and 

administrators also make assumptions about the computing skills of the Net Generation and often 

expect or assume that today’s youth are arriving on campuses with the computer skills needed to 

be successful in college. This assumption has led to the discontinuation of introductory computer 

classes on some college campuses across the country (Hulick & Valentine, 2008; Shannon, 

2008). 

Computer self-efficacy plays an important role in assessing the effectiveness of computer 

education programs as well as assessing the computer proficiency of students (Stephens, 2006). 

Because training increases levels of SE (Bandura, 1986), it is important to find relevant 

applicable training methods to enhance CSE (Marakas et al., 1998). Self-efficacy levels need to 

be adequate so that students will decide to take advantage of opportunities to use their ability 

(Compeau et al., 1999; Stephens, 2006). One of the first things technology instructors need to do 

is assess the proficiency of incoming students and provide individualized training and assessment 

to afford students the computing skills they need to be successful in college and to increase 

levels of computing self-efficacy. 

Generation Y and Computing Experiences 

The Net Generation encompasses young individuals under 30 years old (Akande, 2008; 

Howe & Strauss, 2000; Sanchez, 2003; Shannon, 2008; Tapscott, 2008) often described as 

having grown up digital due to the availability of digital devices in their lifetime. Aside from 
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exposure to computers, cell phones, i-Pods, and social networking sites, the generation is also 

defined by perceived generational relationships. Tapscott (2008) considered the youth of the Net 

Generation to be part of what he called a democratic family, which is much different from the 

top-down hierarchy of the typical family in the 1950s and 1960s. Tapscott further suggested that 

growing up in collaborative families increases the closeness between parents and children. 

Researchers and media often describe “Gen Net” parents as “helicopter parents,” meaning that 

they are deeply involved in all aspects of their children’s lives including keeping their children 

very scheduled (Tapscott, 2008). Unstructured, free time for the youth of this generation 

experience has declined by 37% (Sanchez, 2003). 

The public perception of this generation of individuals is that they are technological wiz-

kids who possess a plethora of technological skills (Wallace & Clariana, 2005). Additionally, 

many of the “Net-Geners” consider themselves technologically skilled based on their personal 

use and noneducational use of computers and digital gadgets. Use of technology can lead to high 

levels of self-efficacy regarding one’s own computing abilities (Considine et al., 2009; Imhof et 

al., 2007; Wilkinson, 2006). Tapscott (2008) claimed that by the time the youth of this 

generation enter their 20s, they will have spent approximately 30,000 hours surfing the Internet 

and playing video games. However, skills used to navigate social networking sites, download 

music, and instant message do not transfer to academic subjects (Shannon, 2008). Transfer of 

knowledge can be positive, negative, or nonexistent (Beard, 1993). The digital skills boys and 

girls have grown up with are not necessarily the skills they are required to use in college or 

business settings, so there appears to be a nonexistent transfer of skills (Shannon, 2008), and 

higher education is left to fill in the gaps in technology training between secondary education 

and the business world (Hulick & Valentine, 2008). Yet, even without specific computer skill 
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training, technology-immersed youths may develop a heightened level of generalized computer 

self-efficacy, which can create a false sense of belief that one will be able to complete specific 

computer tasks based on general computer experiences (Downey & McMurtrey, 2007).  

Self-Efficacy Theory (SET) 

Bandura (1986) defined self-efficacy as “people’s judgments of their capabilities to 

organize and execute courses of action required to attain designated types of performances” 

(p. 391). Perceived self-efficacy is a judgment of capability to perform a given task (Bandura, 

2006). Research consistently uses this definition, and it has not appeared to change over the 

years. Bandura (2006) also stated that one’s perceived efficacy determines whether one thinks 

positively or negatively about a task and influences decisions that individuals make regarding 

whether or not to attempt a task. The idea of self-efficacy derived from the widely accepted and 

empirically validated model of individual behavior referred to as social cognitive theory 

(Bandura, 1977, 1982, 1986). Social cognitive theory suggests that behavior, cognition, and the 

environment exist in a shared relationship working together to assist in one being able to 

generate self-appraisals of capability. 

Bandura (1977, 2006) suggested that actually mastering a behavior that one thought one 

could not can increase one’s sense of efficacy and reduce fears or self-doubt associated with that 

behavior. Multiple research studies have concluded that SE is a significant predictor of 

subsequent task-specific performance (Marakas et al., 1998). Self-efficacy plays a part in 

deciding whether to attempt various kinds of behavior, including computing behavior. 

Experience in completing tasks on a computer is likely to increase self-efficacy regarding 

computers (Compeau & Higgins, 1995; Hill et al., 1987). Many research studies have been 
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conducted regarding one’s self-efficacy in regard to using a computer. This type of self-efficacy 

is referred to as computer self-efficacy (CSE). 

Computer-Self Efficacy (CSE) 

Computer self-efficacy is a growing research field of study (Downey & McMurtrey, 

2007; Marakas et al., 1998). Compeau and Higgins (1995) defined computer self-efficacy (CSE) 

as an individual judgment of one’s capability to use a computer. CSE helps one decide whether 

to use a computer (Marakas et al., 1998). It is not concerned with what one has done in the past 

but is focused on what one can do in the future. CSE is multileveled, meaning CSE reflects 

computing ability at an application-specific level or task-specific level (TCSE) as well as at a 

general level (GCSE; Marakas et al., 1998). General computer self-efficacy (GCSE) assesses an 

individual’s CSE for all computing domains, whereas task-specific computer self-efficacy or 

TCSE assesses individual CSE within subdomains (Downey & McMurtrey, 2007; Marakas et al., 

1998; Stephens, 2006). Another form of CSE called profession-oriented computer self-efficacy 

(PCSE) is a collection of TCSE’s needed to work in a particular profession (Stephens, 2006). 

Computer self-efficacy reflects the capability of what is to be expected. Students with higher 

levels of computer self-efficacy may perceive themselves more able to complete difficult 

computing tasks than students with lower levels of CSE. The more self-efficacy one has, the 

higher the confidence one has regarding his or her ability to perform computing tasks. 

According to Bandura (2006), no all-purpose measure of self-efficacy exists. Many 

instruments exist to measure CSE. Computer self-efficacy instruments do not differentiate 

between GCSE and TCSE. Ideally, one scale should exist to measure CSE, whereas multiple 

scales should exist to measure TCSE and PCSE (Stephens, 2006). Computer self-efficacy can be 

measured on either the specific or the general level (Downey & McMurtrey, 2007). Computer 
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self-efficacy of specific computer applications such as word processing, spreadsheets, databases, 

or presentation software is measured using a TCSE instrument. These instruments are usually 

task based, asking participants to judge their confidence or ability to complete a specific task of 

varying levels of difficulty within a particular domain. The results are summed or averaged to 

determine an individual’s computer self-efficacy for that domain (Downey & McMurtrey, 2007). 

TCSE scales are designed to fit the particular domain of performance that is being assessed 

(Bandura, 2006).  

Measuring CSE for the entire computing domain can be done using a general CSE 

instrument that is not task specific and is much larger than a TCSE instrument (Downey & 

McMurtrey, 2007). The advantage of such an instrument is that it provides information spanning 

the entire computing domain that transfers between computing domains, whereas TCSE 

instruments only provide information on particular types of applications or software packages 

(Downey & McMurtrey, 2007). 

Compeau and Higgins (1995) cited many early studies regarding self-efficacy and 

computing in their research. Some of the research cited by Compeau and Higgins includes 

studies by Hill et al. (1987) regarding computer self-efficacy and enrollment in computer classes, 

adoption of technology products (Hill et al., 1987), innovations (Burkhardt & Brass, 1990), and 

performance training software (Gist, Schwoerer, & Rosen, 1989). Compeau and Higgins (1995) 

reported that previous studies suggest the need for further research exploring the role of self-

efficacy and computing behaviors. Compeau and Higgins’s (1995) research on assessing 

computer self-efficacy focused on the CSE of business managers and professionals in a 

workplace. Prior to Compeau and Higgins’s study, Burkhart and Brass (1990) used a three-item 

scale to measure CSE. Their study measured general perceptions about an individual’s ability to 
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use computers in the workplace. Gist et al. (1989) examined the CSE of managers using two 

training methods. Participants were pretested and then trained for 3 hours via modeling or 

tutorials. A mid-point assessment was taken of software self-efficacy, and post-training measures 

were taken of performance, working style, affective responses, and course satisfaction. They 

concluded that the behavior modeling training sessions increased CSE more so than the tutorial 

training session did. However, both types of training increased the CSE of participants at the 

conclusion of training. In 1987, Hill et al. conducted a study regarding self-efficacy and people’s 

readiness to enroll in computer classes. A questionnaire to assess CSE beliefs was administered 

to 204 students enrolled in an introductory psychology class. The questionnaire also probed 

students’ intentions to enroll in computer courses in the future. The questionnaire was developed 

by the researchers during an earlier study in 1985 and used a 5-point scale ranging from 1 

(totally agree) with the statement to 5 (totally disagree) with the statement. Results were then 

coded and measured against actual enrollment in a computer class 12 weeks after the survey was 

completed. Results showed that higher levels of CSE could be used to predict future enrollment 

in computer classes. 

 Another study by Hill et al. (1986) explored the role CSE plays in the decision to adopt 

certain technologies. Their research provided evidence that computer self-efficacy, as an 

important factor in student decision making regarding using computers and CSE, can be 

generalized to affect an individual’s adoption choices regarding various technologically 

advanced products. 

Havelka (2003) conducted a study to explore the impact of individual characteristics on 

computer self-efficacy. Results suggest that males, younger aged users, overall confidence level, 

computer experience, low math anxiety, and a creative cognitive style are associated with higher 
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levels of CSE. Chung, Schwager, and Turner (2002) conducted a computer self-efficacy study to 

determine which college major had students with the highest CSE levels. Their study revealed 

that business majors had higher levels of computer self-efficacy than education, forest/wildlife, 

or liberal arts majors did. Additionally, Havelka’s (2003) study found significant differences of 

CSE among the various business disciplines. MIS and economics majors had the highest levels 

of CSE, whereas management and general business majors had the lowest levels of CSE. 

Findings in the Havelka study also showed a positive relationship between the number of years 

of experience using a computer and a student’s level of CSE. 

Imhof, Vollmeyer, and Beierlein (2007) surveyed a small group (N = 48) of university 

students regarding computer self-efficacy. Based on earlier research findings, they predicted that 

males would report higher computer self-efficacy than females; but their findings did not support 

this theory. They suggested that the gap between male and female self-efficacy is closing. This is 

a realistic assumption, because CSE has been associated with time spent using a computer, and 

studies report that girls now use computers at the same rate as boys (Lewis, 2007). Havelka 

(2003) reported similar findings. Although males tended to report higher levels of CSE, the 

difference was not significant enough to state that gender affected computer self-efficacy. 

Other studies have been conducted to explore relationships between CSE and computer 

performance. Smith (2001) designed and administered a CSE assessment to a small group (N = 

10) of undergraduate students at a Midwest university, and then administered a computer 

performance assessment asking students to complete tasks using word processing, spreadsheets, 

databases, presentation graphics, graphical user interface (GUI) management and 

telecommunications. Findings concluded that students’ perceived ability to complete computing 

tasks surpassed performance. Grant et al. (2009) conducted a similar study. In their study, TCSE 



 

18 

results were compared to performance assessment scores of word processing, spreadsheet, and 

presentation tasks. Their results indicate some difference between CSE and word processing 

performance, little to no difference between CSE and presentation performance, and significant 

differences between CSE and spreadsheet performance. The results of this study were then used 

to realign and enhance the university’s introductory computer courses. Less time was devoted to 

teaching word processing and presentation skills, and more time was allocated for teaching 

spreadsheet skills (Grant et al., 2009). 

The number of computer courses taken in high school also appears to have a relationship 

with CSE. Havelka (2003) found significant differences between those with greater than three 

computer courses and those students with only one or two courses. The researcher suggested that 

computer self-efficacy in not significantly affected by computer courses until they have 

completed more than three computer courses. 

Computer self-efficacy levels need to be adequate so that students will decide to take 

advantage of opportunities to use their ability (Compeau, Higgins, & Huff, 1999; Stephens, 

2006). General self-efficacy develops over time and is a compilation of experiences (Bandura, 

1997). General self-efficacy can transfer among similar domains (Downey & McMurtrey, 2007) 

and may account for higher computer self-efficacy ratings than actual performance scores among 

the digital generation of college students. This can be detrimental for college students, because 

some students will use their heightened sense of computer self-efficacy as a reason to believe 

that introductory college courses are easy and, therefore, may not prepare adequately for lessons 

or exams (Downey & McMurtrey, 2007; Smith, 2001).  
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Secondary Technology Standards 

Despite the facts that computer skills are important in secondary and postsecondary 

education (Shannon, 2008) and that opportunities to learn and use technology have increased in 

elementary and secondary schools (Stephens, 2006), discrepancies abound when it comes to 

mandatory technology training in our nation’s secondary schools. Henke (2007) believed that 

this is due to the lack of strong national technology policies, empowered educational leadership, 

and continued communication involving business, education, government, and the community. 

Unlike graduation requirements for Math or English, schools differ greatly in the number and 

type of elective computer classes they offer (Ceccucci, 2006). Whereas some schools offer only 

basic computer skill courses, others like Tucson, Arizona’s Empire High School (McHale, 2008) 

are changing the pedagogy of education and are operating in a one-to-one computing 

environment where their entire secondary educational experience involves utilizing technology. 

In 2005, Ceccucci reviewed technology standards of over 100 high schools of varying region, 

locality, and size. Her findings indicate that 99% of the high schools surveyed offered some type 

of computer application class, but only 13% required students to take a semester or more of 

computer applications courses. The other 87% do not require students to pass any computer 

courses, although many schools offer elective courses in web publishing, ecommerce, 

programming, and graphics. These statistics are important to consider because CSE levels are 

said to be predictors of computing performance, and according to Havelka’s 2003 study, self-

efficacy does not significantly increase until students have completed three or more computing 

classes. 

 Additionally, 21 states offer technology exit exams, but only two states (North Carolina 

and Nevada) require a computer proficiency exam as part of the state’s graduation requirement. 
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For example, Nevada requires students to pass a proficiency exam or to complete a semester-

based course involving computer literacy. Even with consistent national education standards for 

technology (NETS, 2007), there is inconsistency in high school computer course offerings and 

requirements. Technology Counts’ 2008 report card (Education Week, 2008) indicated that only 

three states received a grade of A when it came to technology leadership (access to, use of, and 

capacity to use technology) in our country’s secondary schools. States receiving A’s were West 

Virginia, South Dakota, and Georgia. The average grade for all states was a C+ (Education 

Week, 2008). Rhode Island was one of the states that received a grade of D on the Technology 

Counts report card (Education Week, 2008). When interviewed about technology practices, all 

Rhode Island teachers participating in the study indicated that they integrated technology in the 

classroom, but 80% of the interviewees and 62% of the survey respondents indicated that they 

did not know that National Education Technology Standards-Students (NETS-S) existed 

(Mancieri, 2008).  

The business world acknowledges the importance of technology training. When asked to 

list the top five skills sought in job candidates, job recruiters indicated computer proficiency was 

second only to oral and written communication skills (Moody, Stewart, & Bolt-Lee, 2002). In 

1996, local businesspersons in Napa, CA began discussions about creating a high school that 

would prepare students for the internet-enabled world and economy. These discussions began 

because of the community’s frustration with schools not preparing students for jobs in the 

technologically complex market place. The solution resulted in the creation of New Technology 

High School. New Technology High, part of the Napa Valley Unified School District, has 

graduated over 750 students. Students in the school use technology with the most recent software 

to engage in project-based learning (PBL) throughout the day. Administrators compare the 
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school environment to being more like being in college or the workplace. In an effort to keep up 

with the latest technological developments, the school created the New Technology Foundation 

(NTF; 2007) to create support for the school and manage grant money. The NTF offers support 

to other communities creating their own New Technology High Schools. The NTF is a 501(c)(3) 

nonprofit organization working toward national education reform with schools that wish to 

model themselves after Napa’s New Technology High School (NTF, 2007). The goal of NTF is 

to help high school students and teachers use technology in ways to create social networking-like 

collaborative learning environments (Utsler, 2008). There are over 42 New Technology High 

schools in 10 states, and 13-15 more will open in August 2009 (NTF, 2007). In March 2009, the 

national public education philanthropy, Knowledge Works Foundation, announced a 4-year, 

$10 million commitment to NTF calling the New Technology High School project “the best-in 

class, most highly-scalable approach to learning in the 21st century that we have seen” 

(Knowledge Works Foundation, 2009). 

Additional technology education incentives are finding their way across the country. 

Eleven states (Arizona, Iowa, Kansas, Maine, Massachusetts, New Jersey, North Carolina, South 

Carolina, South Dakota, West Virginia, and Wisconsin) currently consider themselves 21st 

Century States, whereas many other states are moving in that direction (Partnership for 21st 

Century Skills, 2007). The primary goal of Partnership for 21st Century Skills is preparing 

students for 21st century life by focusing on the learning needs of the future especially in the 

areas of science and technology. In 21st century skill schools, the core subjects are still the strong 

base of the framework, but interdisciplinary themes such as global awareness, financial, 

economic, business, civic, and entrepreneurial literacy all play a role in instruction of the core 

subjects. Critical thinking and problem solving, creativity and innovation, and communication 
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and collaboration are the emphasis in such schools, along with information, media, and 

technology skills, as well as life and career skills (Partnership for 21st Century Skills, 2007). 

New Technology High Schools, 21st Century Schools and one-to-one computing 

initiatives are working to meet the technology demands of our digital society (McHale, 2008; 

NTF, 2007; Partnership for 21st Century Skills, 2007). However, not all students have access to 

such innovative programs, and students are coming to college with varying degrees of computer 

knowledge. Colleges and universities need to prepare to assess the computer self-efficacy and 

computer proficiency of incoming students and must plan to meet the advanced or remedial 

training needs of students (Ceccucci, 2006). 

College and Computing 

Colleges and universities are discovering firsthand the lack of computer knowledge of 

incoming students. Rafaill and Peach (2001) predicted that computer proficiency would increase 

with each new group of students arriving on campus. Literature disagrees on what constitutes 

computer literacy, computer competency, and computer proficiency (Templeton et al., 2003). 

The terms can be used interchangeably and have various meanings depending on the source 

(Hulick & Valentine, 2008). Part of the problem with defining computer literacy/competency/ 

proficiency is that the definition is constantly changing due to technology not being static 

(VanLengen, 2007). Wilkinson (2006) stated, “The definition is broad but usually entails the 

knowledge of basic computer concepts as well as hardware concepts and the basic use of word 

processing, spreadsheet, database, and presentation software” (p. 110). Hulick and Valentine 

reported multiple meanings of computer literacy from various sources. He reported that the 

Harvard Law website defines computer literacy as “the degree to which individuals are familiar 

with computer operating systems and applications” (p. 1). The definition on the Austin 
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Community College website states a student is computer literate when “a user has basic 

knowledge of computer operations (copying files, printing documents, etc.); basic software 

applications (word processing, spreadsheets, etc.); email functions (sending/receiving messages, 

attaching files, etc.)” (as cited in Hulick & Valentine, 2008). Colleges and Universities often 

develop their own definition for computer proficiency and create their own computer proficiency 

requirements (Wilkinson, 2006). The definition of computer proficiency and the content of 

computer course offerings are to be continually reviewed and updated as technology, employer 

demands, and student capabilities change (VanLengen, 2007). 

Regardless of varying definitions, studies conducted in the past 10 years assessing 

computer proficiency of postsecondary students have concluded with similar findings indicating 

that computer literacy is not improving. For example, in the fall of 1999, Georgetown College 

implemented an Information Technology Program. The purpose of the program was to ensure the 

computer proficiency of all students. Passing the proficiency exam became a graduation 

requirement. Although it was a requirement for graduation, the college acknowledged the 

importance of attaining these skills early in the college experience and required a passing 

proficiency score prior to the student’s sophomore year in college. In the first 2 years of testing, 

less than 50% of students passed the test (Rafaill & Peach, 2001). No information regarding 

Georgetown’s Information Technology Program is available dating after 2003. A study 

conducted by Wallace and Clariana (2005) tested 140 entering business students and reported 

that only 36% of the students would be able to “test out” of an introductory computer course if 

given that option. Hulick and Valentine’s (2008) study of computer competency of 1,500 

incoming college students during the spring of 2008 found that over half of students assessed did 

not have the necessary computer skills to function in an information-based society. At least one 
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study is reporting change. A study at Butler University’s College of Business Administration 

suggests that some students may be coming into their program with increased computer skills, 

but more than half are not, causing a wider gap between student needs (Templeton et al., 2003).  

Research cited has established that less than half of the students entering college and 

universities are able to pass a basic computer proficiency test. This research affirms the need and 

importance of introductory computer courses offerings at the postsecondary level (Ceccucci, 

2006; VanLengen, 2007). However, some schools are doing away with computer course 

requirements based on the assumption that students arrive on campus with the computer skills 

necessary to be successful (Wallace & Clariana, 2005). Other reasons cited for eliminating 

introductory computer courses include low faculty resources and reduction of graduation 

requirements due to the 120-Hour Rule (Shannon, 2008; Templeton et al, 2003). Richard Bland 

College reported that beginning in fall 2008 the 3-hr computer proficiency requirement changed 

to a computer proficiency requirement of 0-3 hrs. A search of the college’s website and core 

requirements did not reveal the reasoning for this change (Richard Bland College, 2008). Butler 

University moved its freshman level computer class to an online computer proficiency 

requirement and effectively reduced the overall graduation requirement by 3-credit hours 

(Templeton et al., 2003). Like Butler University, many schools are considering eliminating 

introductory computer science courses as part of the core curriculum due to the 120 Hour Rule. 

The Southern Association of Colleges and Schools (SACS) calls for baccalaureate degrees not to 

be more than 120 credit hours (THECB, 2009). Schools across the nation are working toward 

this goal and evaluating course requirements to trim their degree programs. In Texas, 23 out of 

34 universities no longer require an introductory computer class as part of the core curriculum 

(Shannon, 2008), although research has shown an average 15%- 20% gain in both computer 
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concepts and software proficiency after taking an introductory computer course (VanLengen, 

2007; Wallace & Clariana, 2005). Other schools are purging introductory courses and favoring 

the idea of teaching these basic technology skills in an “across the curriculum” approach. This 

approach integrates the computer basics within each individual course offering (Rafaill & Peach, 

2001). 

The need for computer skills at the college level has been dutifully noted (Hardy, 2005; 

Hulick & Valentine, 2008; Wilkinson, 2006), and it would be considered unwise to do away with 

introductory course offerings based on the assumption that students are arriving on campus 

possessing these skills. Wallace and Clariana (2005) suggested that introductory computer 

classes need to continue to be part of college and university course offerings, along with offering 

proficiency exams as an alternative to taking basic computer literacy courses. Even when 

students have the choice of taking a computer course or a proficiency exam to meet computer 

proficiency requirements, the majority of students select to take an introductory computer course 

over a proficiency test (Coolbaugh, 2004).  

A medium-sized university in North Carolina is using TCSE and computer performance 

assessments to enhance and realign their introductory computer courses. After evaluating the 

TCSE of 200 business students and finding it a good indicator of word processing and 

presentation skills, but not for spreadsheet skills, the university decreased the amount of word 

processing and presentation skills being taught and increased the spreadsheet skills being taught 

in an effort to align student training to meet student needs (Grant et al., 2009). 

One unnamed university is using the scores of student computer self-efficacy assessments 

to assist in the training of students prior to taking a computer proficiency exam. Incoming 

business students at the university where the research was conducted are required to pass a 
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computer proficiency exam. Prior to taking the computer proficiency exam, students are assessed 

using the business computer self-efficacy scale to determine business computer self-efficacy. 

Students with high scores on the BCSE scale gained access to a website with self-study materials 

they could use to review prior to taking a proficiency exam. Students with mid-range skills 

participated in a self-paced, on-line computer course that used self-study materials, assignments, 

and Q & A sessions prior to taking a computer proficiency exam. Students with low BCSE 

scores enrolled in a traditional, semester long, lab-based computer course. The same proficiency 

exam was administered to all students. In addition to addressing individual training needs of 

students and increasing success on the computer proficiency exam, this process is expected to 

reduce costs due to the need for fewer instructors and fewer class sections (Stephens, 2006). 

Assessment and Training 

Computer self-efficacy plays an important role in assessing the effectiveness of computer 

education programs as well as assessing the computer proficiency of students (Stephens, 2006). 

Because training increases levels of SE (Bandura, 1986), it is important to find relevant 

applicable training methods to enhance CSE (Marakas et al., 1998). Self-efficacy levels need to 

be adequate so that students will decide to take advantage of opportunities to use their ability 

(Compeau et al., 1999; Stephens, 2006). One of the first things technology instructors need to do 

is assess the CSE and computer proficiency of incoming students and provide individualized 

training and assessment in order to provide students with the computing skills they need to be 

successful in college and to increase levels of computing self-efficacy. Smith (2001) suggested 

that CSE assessment along with computer performance assessment can aid in identifying 

academic strengths while offering clues to students’ self-perceived obstacles to learning about 

computing. 
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Testing for TCSE is not a common practice on college campuses, but testing for 

computer proficiency is a growing trend even though it has not reached the levels of other 

traditional placement or proficiency exams. Ninety percent of colleges offer students the 

opportunity for advanced placement in math, English, foreign language, and other classes by 

passing standardized advanced placement tests administered by the College Entrance 

Examination Board. Additionally, some colleges offer the College Level Examination Program 

(CLEP). CLEP exams offer end-of-course exams for specified courses. Students passing such 

exams are rewarded credit hours without having to take the actual course for the subject. The 

number of advanced placement exams taken has increased 75% between the years of 1999-2005 

(Tapscott, 2008). Although none of these programs offers a placement exam for introductory 

computer skills (College Board, 2009), other commercial testing programs do. 

 Educational Testing Service (ETS) provides the iSkills exam to colleges and universities 

for a cost of about $22-$33 per students depending on the number of exams ordered. The 75-

minute online exam assesses proficiencies in the seven areas of Information Communication 

Technology (ICT) via 14 short 4-minute tasks and one long 15-minute task. Scores are available 

within 10 days of taking the test (ETS, 2009). The International Computer Driving License 

(ICDL), originally designed for corporate training, offers a computer- skill certification program 

assessing basic concepts, file management, word processing, spreadsheets, database, 

presentations, communications, and information. Individuals taking the test and passing all seven 

parts of the exam receive an ICDL certification card to prove achievement in these computer 

skill areas (ICDL, n.d.). Colorado State University is one of the schools using this product to test 

their students (Wilkinson, 2006). 
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Microsoft offers an array of certifications to demonstrate expertise with their products. 

The Microsoft Certified Application Specialist (MCAS) certifies skills using Office 2007 and 

Windows Vista. Individuals desiring to take an MCAS certification exam can go online and find 

an official testing center. Each exam can cost up to $125 (Microsoft, 2009). 

In addition to the available commercial testing options, alternatives for testing student 

proficiency are found in web-based training and assessment products like Triad Interactive’s 

SimNet product distributed by McGraw-Hill Higher Education (McGraw-Hill Higher Education, 

2007), and Course Technology’s Skill Assessment Management (SAM) distributed by Cengage 

Learning (Cengage Learning, 2008). Both products present training and assessment in a 

simulated computer environment that has the student perform given tasks. These programs are 

widely used on college campuses in introductory computer classes as a way to assess proficiency 

as well as to train and remediate students in areas where skill proficiency may be short of the 

point of mastery. Unlike the commercial certifications mentioned earlier, these products allow 

instructors or administrators permissions to custom design proficiency exams to meet the needs 

of computer skills needed at a particular campus or to meet the needs of specific majors. Some 

schools, like Butler University’s College of Business Administration, are using products such as 

these to move away from an introductory computing course requirement to a proficiency-testing 

requirement (Templeton et al., 2003). Competency-based training and assessment programs are 

growing in popularity on college and university campuses because of the product features that 

create individualized instruction to fill the gap between actual student knowledge and necessary 

knowledge of computer skills at the postsecondary level (Cengage Learning, 2008; McGraw-Hill 

Higher Education, 2007). Due to the newness of recently released competency-based products 

for Office 2007, no literature appears to exist regarding studies conducted to evaluate the 
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effectiveness of the products. As suggested by Smith (2001), using TCSE evaluations along with 

task-based assessment and training products can assist in recognizing students’ strengths and 

weaknesses and provide students with the individualized training needed to ensure the 

development of the computer skills required to be successful at the college level. 

Summary 

In summary, youth of Generation Y are immersed in a digital culture. Technological 

tasks such as social networking, online gaming and emailing are not transferring to the skills 

needed in college, but successful completion of and frequent use of such tasks are generating 

heightened levels of perceived computing ability (Smith, 2001). Research has concluded that 

basic computer skills involving word processing, spreadsheets, databases, presentation software, 

and the internet are valued skills at the postsecondary level (Hardy, 2005; Hulick & Valentine, 

2008; Wilkinson, 2006; Wolk, 2008). Due to inconsistent technology standards and requirements 

in secondary education, students are arriving on college campus with a wide range of computing 

abilities, and colleges and universities need to be able to meet and embrace varying student 

abilities (Ceccucci, 2006). 

Colleges and universities meet computer proficiency requirements in various ways, 

including credit courses (most frequent), proficiency testing, online help, and noncredit 

workshops (Wilkinson, 2006). Initially, introductory computer classes focused on teaching basic 

programming skills; however, as technology changed, introductory computer classes morphed 

into instructional courses on how to use a computer (Gill & Hu, 1999; Templeton et al., 2003; 

VanLengen, 2007). As higher education classrooms incorporate more technology into courses, 

the importance of students possessing essential computer skills becomes more significant (Beard, 

1993; Hardy, 2005; Hulick & Valentine, 2008; Wilkinson, 2006). Many schools are using 
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computer competency-based training products, such as Triad Interactive’s SimNet Online for 

Office 2007, to meet individualized student computer training needs (McGraw-Hill Higher 

Education, 2007). However, there is little empirical research on the effectiveness of the new 

product releases for Office 2007.  
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CHAPTER 3 

METHOD  

Introduction 

Literature strongly supports the idea that students are coming to college without the skills 

they need to be considered computer proficient (Coolbaugh, 2004; Hardy, 2005; Hulick & 

Valentine, 2008; Templeton et al., 2003; VanLengen, 2007). The purpose of this study is to 

explore the relationship between task-specific computer self-efficacy (SCSE) and computer 

proficiency regarding completion of tasks using the Vista operating system and Office 2007 

applications Access, Excel, PowerPoint, and Word. Self-efficacy theory (SET) states that self-

efficacy is a reliable indicator of performance (Bandura, 1977), however, recent research 

assessing computer self-efficacy and computer performance has found that computer self-

efficacy ratings are often higher than performance scores (Grant et al., 2009; Smith, 2001). This 

study examined whether students enrolling in the introductory course were already computer 

proficient. Additionally, results helped to determine whether computer self-efficacy and 

performance increase after completing an introductory college-level computer course and 

whether there appeared to still be a need to offer introductory computer courses at the college 

level. Discussion of the effectiveness of the task-based training product, SimNet for Office 2007, 

currently used in the university’s introductory computer classes is included in chapter 5.This 

chapter includes a description of the course environment, how each research question will be 

addressed, participants involved, the instrumentation used, and how data were collected and 

analyzed. 
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Setting 

This study took place at a large public 4-year university in the Southeastern United 

States. The study recruited participants from students enrolled in that college’s introductory 

computer science courses titled CS102, Microcomputer Applications I, offered during the fall 

2009 semester. Enrollment at the university for the fall 2009 semester set an enrollment record of 

28,807 students. The university where the study took place offers programs of study in 12 

academic divisions that lead to degrees at the levels of bachelor’s, master’s, Education Specialist, 

and doctoral areas of study.  

CS102 (Course Background) 

Microcomputer Applications 1 (CS102) is an introductory computer course that provides 

instruction in Microsoft Office applications (Access, Excel, PowerPoint, & Word), Microsoft 

Vista, and computer concepts. The course serves as a prerequisite course for other computer 

classes on the campus, as well as a statistics course offered in the College of Commerce and 

Business Administration (C&BA). Only Business and Nursing majors are required to take 

CS102. However, the university accepts two semesters of computer science courses in place of 

the University’s two semesters of foreign language requirement; this is a popular option for 

students on campus. For students choosing to take two semesters of computer courses instead of 

two semesters of foreign language, students must take CS102 as a prerequisite prior to enrolling 

in the two semesters of computer classes. In 2008, over 3,000 students enrolled in CS102 during 

the spring, summer, and fall semesters.  

Prior to fall 2002, CS102 was taught in large lecture halls, and the classes consisted of a 

lecture, demonstrations, textbook readings, projects, quizzes, three paper-and-pencil multiple-

choice exams, and a paper-and-pencil multiple-choice final exam. Topics covered included 
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Windows 2000, Access, Excel, PowerPoint, and Word and computer concepts. Attendance was 

poor, scores were low, and course evaluations indicated students wanted computers in the 

computer class. A proficiency test was available to students that wanted to test out of CS102. 

The proficiency test was a paper-and-pencil multiple-choice exam consisting of 70 questions 

regarding Microsoft applications covered in class. Very few students opted to take advantage of 

this opportunity and of those that did, roughly 11% of students passed the exam (University 

Testing Services, personal communication, February 23, 2009). 

 Beginning in fall 2002, CS102 moved instruction into a computer lab consisting of 120 

computers. Rather than lecturing, students were required to purchase a textbook for Office 2003, 

a textbook for Computer Concepts, and a SimNet for Office 2003 CD that contained lessons and 

practice exams for home use. The computers in the lab had SimNet for Office 2003 installed on 

all of the computers. Assignments included readings from the textbooks and completion of 

lessons and practice exams in SimNet 2003. Multiple instructors were assigned across class 

sections, and the instructors served in supporting roles, as the focus of the class became more 

student centered. For each topic module, students used the SimNet software to pretest, to practice 

the material for a week, and to take an exit exam for that module. Students would follow this 

pattern throughout the semester for each module topic covered. Informal surveying of students at 

the end of each semester revealed favorable responses to SimNet for Office 2003, but some 

students believed they were wasting time covering material they already knew. For example, 

students believed they were proficient in Microsoft Word and, therefore, believed it was a waste 

of time to sit and read and to practice skills they felt they already had mastered. Many students 

complained about high textbook costs and the lack of use of the textbooks in class because 

testable information was available in SimNet for Office 2003 software. Additionally, in attempts 
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to save money, students were not purchasing the SimNet CDs for home use because they had 

access to SimNet installed on all the CS102 lab machines. Another concern was that SimNet for 

Office 2003 was not Mac compatible, and some students believed that the compatibility issue put 

them at a disadvantage for not being able to study and practice the material from home. For 

students wishing to test out of CS102, University Testing Services continued to use the 70 

questions, paper -and- pencil multiple-choice exam used during previous semesters.  

Between fall 2003 and spring 2006, many changes were made to the CS102 curriculum to 

make it more student focused and content relevant. First, removing a wall in the computer lab 

allowed the addition of 44 computers to help with growing enrollment. Four privacy cubicles (to 

create a reduced distraction environment) and four more wheel chair accessible stations were 

added for those needing specific accommodations. Next, textbooks were no longer required or 

used in class. All content was delivered solely via the SimNet 2003 software. Rather than 

determined class meeting times during the week, practice weeks became “flex-weeks,” and 

students were able to come any time during the week that the lab was open to complete required 

lab time. Required lab time was based on 3 hours (180 minutes) of practice time in the lab. 

Students were given the opportunity to reduce the amount of practice time they had each week 

by scoring well on their pretest for each module. Students scoring 90-100% on the pretest were 

only assigned 60 minutes of practice time in the lab. Those scoring 80%-89% had 120 minutes of 

required practice, and those scoring 79% or below were required to complete the full 3 hours of 

lab time. Reducing the amount of time students spent in the lab based on pretest scores 

accommodated those students with previous skill knowledge. If students made an “A” on a 

pretest, then it was assumed that they had a good knowledge base of the material and did not 

need as much practice time learning the material as someone scoring a 60% on the pretest. The 
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more the pretest revealed a student knew, the less time the student had to spend in the lab for that 

particular module. Once students completed required lab time, they were not required to return to 

class until their scheduled test date for that particular module. Students were expected to 

continue practicing and preparing for the exam from home. All skill objectives associated with 

the Microsoft Office User Specialist certification exam were available in the content of the 

students’ assigned lessons; however, students were able to select and work lessons in the order of 

their choosing and were able to create custom lessons in SimNet to review only the lessons of the 

skills missed on the pretest. A comparison of scores revealed an average of a 27% gain between 

pretest scores and posttest scores on all module topics covered during the semester. 

Although a CS102 correspondence class existed at the university, SimNet’s release of a 

Web-CT/Blackboard compatible version of SimNet titled SimNet Enterprise enabled the creation 

of a true online, distance-learning version of the class. A new CS102 placement exam was 

developed as well. Using screen shots from the SimNet program, students answered 70 multiple-

choice questions regarding Office 2003 applications. Very few students opted to take the 

placement exam, and very few that chose to take the exam passed the exam. The online CS102 

course offering became the first class offered as part of the online Computer Technology & 

Applications minor that was developed for online delivery to go along with the online General 

Business degree offered by the College of Commerce and Business Administration. 

The release of Office 2007 by Microsoft in the spring of 2006 elicited an array of new 

competency based products to the postsecondary education market. An extensive evaluation of 

new products was conducted. Instructors looked closely at the new SimNet Online for Office 

2007 (McGraw-Hill), SAMs for Office 2007 (Course Technology/Cengage), and MyItLab 

(Pearson Learning). The decision was made to adopt SimNet Online for Office 2007 based on 
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available content, instructional, practice and evaluation components, the ability to offer a 

proficiency exam, ease of management, student tech support, student cost, minimum system 

requirements, PC and Mac capability, total web-based delivery, and scheduled content updates. 

Developed by Triad Interactive, Inc. for McGraw-Hill Higher Education Publishing, 

SimNet Online for Office 2007 is a web-based program designed to teach and assess competency 

in Microsoft 2007, Microsoft Vista, Windows XP, and computer concepts. The program also 

includes a complete course management system offering course tools that allow instructors to 

monitor student usage, evaluate students, communicate with students, minimize preparation time, 

perform automated grading, generate reports to measure student outcomes, export grades, and 

keep a grade book. The requirements to run SimNet Online are Windows XP, or Vista, a web 

browser (IE7 or Firefox 2.x), Adobe Flash 9, Adobe Acrobat Reader, 1GHz+ processor, 512MB 

RAM (although 1GBz+ is recommended), and a screen resolution of 1024x768px or higher. 

SimNet Online runs on both PCs and on Macs (McGraw-Hill Higher Education, 2007). 

Like SimNet for Office 2003, the instructional premise of SimNet Online utilizes the 

learning methodology of “Teach Me, Show Me, Let Me Try” (McGraw-Hill Higher Education, 

2007). Content validity aligns with Microsoft Certified Application Specialist (MCAS) 

objectives. The “Teach Me Section” consists of text and graphics explaining the skill to be 

learned and provides brief step-by -step directions. The “Teach Me Section” also supplies 

information regarding how to use the skill and when an individual would use the skill. Additional 

components called “Tips & Tricks,” “Tell Me More,” and “Try This” provide supplementary 

information about the skill including alternate ways of performing the skill, keyboard shortcuts, 

and exercises to attempt in the actual application. The “Show Me” element of the product 

provides an audio and visual component that talks the student through the process of performing 
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a skill while showing a short video demonstrating how to perform the skill. The “Let Me Try” 

component provides practice for the student to complete a task by breaking it down into simple 

commands to walk the student through completing the skill topic. SimNet Online also provides 

instructor control of lessons and exam content. The product provides multiple opportunities for 

practicing skills in various scenarios. A 2006 study on instructional elements (information, 

objectives, examples, practice, and review) found that practice was the key component when it 

came to student achievement and attitudes toward the course (Martin, Klein, & Sullivan, 2007). 

Furthermore, unlike previous versions of SimNet, SimNet Online for Office 2007 has the 

capability to create cross-module exams lending to the ability to create a comprehensive 

proficiency exam (McGraw-Hill Higher Education, 2007). 

CS102 began using SimNet Online for Office 2007 in fall 2007. Similar to earlier 

semesters, no textbooks were required, but all students were required to purchase a SimNet 

Online for Office 2007 registration code. Registration codes were available at university 

bookstores, or students could purchase a registration code by using a credit or debit card when 

first logging into SimNet Online. The e-commerce site was not only convenient, but also helped 

keep bookstore price mark-ups at a minimum. The format of CS102 continued to use a pretest, 

practice, and posttest cycle. However, class time requirements were re-examined. Required lab 

time was reduced for those scoring well on the pretests. Students scoring 90%-100%, had no 

required lab time assigned. It was determined that these individuals knew the material well 

enough that they could continue practicing and reviewing on their own as they felt necessary. 

Students scoring between 80-89% on the pretest were required to spend at least 40 minutes of 

time practicing in the lab. Students scoring between 65%-79% had to complete 80 minutes of 

required lab time, and students scoring below 65% and students that did not take the pretest were 
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required to spend 120 minutes of practice time in the lab. Although SimNet Online is a web-

based product and accessible from various locations, lab time was still a requirement because 

CS102 was considered a campus course and campus meetings were required. Additionally, 

required lab time guaranteed that students lacking certain skill were spending time learning 

necessary skill content. Favorable informal postcourse evaluations by Computer Science faculty 

and staff regarding ease of management, perceived student satisfaction, and training 

effectiveness indicated that the adoption of SimNet Online for Office 2007 for the 2007-2008 

academic year was considered a success, and a decision to continue using the product was made. 

In spring 2008 instructors from the Computer Science Department and the College of 

Commerce and Business Administration met to discuss the possibility of testing the computer 

skills proficiency of incoming business students. Assumptions were made that incoming students 

should arrive possessing basic computer applications skills and should be able to pass a basic 

computer application proficiency exam. Further meetings were held to discuss test content and 

delivery methods. A computer proficiency exam was developed using SimNet Online, consisting 

of MCAS objectives selected based on CS102 course content and the skills that instructors of 

other courses that CS102 serves as a prerequisite identified as necessary to perform well in those 

specific courses. The finished product consisted of 100 weighted tasks to be completed in a 

simulated environment. Thirty percent of the tasks would require use of Microsoft Word 

knowledge, 40% utilized Microsoft Excel knowledge, 10% Microsoft PowerPoint, and 20% 

required knowledge of computer concepts, IE7, and Vista. Instructors from courses that CS102 

feeds into insisted on the high percentage of Excel tasks. They did not want students entering 

their classrooms who could pass the Word, PPT, and other skills sections, but failed the Excel 

portion and would, then, be able to receive a passing score on the exam. A passing score was set 
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at 380 earned points out of a possible 500 points, or 76%. When developing the proficiency 

exam, University Testing Services advised that the passing score needed to remain consistent 

with earlier versions of the exam. 

Entering College of Commerce and Business Administration students received advising 

during orientation during the summer of 2008. Students were informally questioned regarding 

their computer abilities and were advised either to register for CS102 in the fall of 2008 or to 

take a proficiency exam during the fall 2008 semester. The majority of students were advised to 

take the placement exams. All incoming C&BA students enrolled in GBA 145, titled Orientation 

to Commerce and Business Administration. The Computer Science department prepared to 

proficiency test approximately 1,200 C&BA students during a 3-week period in the fall of 2008. 

GBA 145 instructors were provided the dates and times of testing from the Computer Science 

Department and communicated this information to the students along with registration 

instructions. Some GBA instructors required their students to take the exam, some only 

encouraged students to take the exam, and some offered extra credit for taking the exam.   

 Results from the fall 2008 proficiency testing indicated that only 403 students registered 

to take the proficiency exam. Even with email reminders sent, only 310 of those 403 showed up 

to take the proficiency exam. Only 231 of the 310 that showed up to take the exam completed the 

entire exam. Of the 231 completing the exam, only 33 (14%) passed the exam. An informal 

questioning of students at check-in revealed that many students showed up to receive credit from 

their teacher but did not feel that they would pass the exam. Others reported failing the exam on 

purpose or ending the test early because they actually wanted to take the CS102 course. Many 

stated that they were proficient in Office 2003, but that Office 2007 was too different and they 

were unfamiliar with it. The results of this testing proficiency experience were very similar to 
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proficiency testing results reviewed in the literature. Based on the results of this experience, the 

Computer Science Department concluded that students were not coming to campus with the 

computer skill set needed to be successful on campus, and that if given the choice, students 

preferred taking an introductory computer class over taking a computer proficiency exam.  

The Study 

The purpose of this study was to explore the relationship between task-specific computer 

self-efficacy (SCSE) and computer proficiency regarding completion of tasks using the Vista 

operating system and Office 2007 applications Access, Excel, PowerPoint, and Word. Self-

efficacy theory (SET) states that self-efficacy is a reliable indicator of performance (Bandura, 

1977), however recent research assessing computer self-efficacy and computer performance has 

found that computer self-efficacy ratings are often higher than performance scores (Grant et al., 

2009; Smith, 2001). This study also examined whether students enrolling in the introductory 

course were already computer proficient. Additionally, results helped to determine whether 

computer self-efficacy and computer skill performance increased after completing an 

introductory college-level computer course and whether there appeared to still be a need to offer 

introductory computer courses at the college level.  

The following research questions were addressed: 

1. Are general computer self-efficacy (GCSE) ratings higher than task-specific 

computer self-efficacy (TCSE) ratings? 

2. Is there a relationship between the number of computer classes taken in high school 

and task-specific computer self-efficacy (TCSE) regarding completing computer tasks 

using Vista and Microsoft Office 2007 applications Access, Excel, PowerPoint, and 

Word? 
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3. Is there a relationship between task-specific computer self-efficacy (TCSE) and 

computer proficiency regarding completing computer tasks using Vista Microsoft 

Office 2007 applications Access, Excel, PowerPoint, and Word? 

4. Does task-specific computer self-efficacy (TCSE) regarding completing computer 

tasks using Vista and Microsoft Office 2007 applications Access, Excel, PowerPoint, 

and Word increase after completing an introductory computer class? 

5. Does computer proficiency regarding completing computer tasks using Vista and 

Microsoft Office 2007 applications Access, Excel, PowerPoint, and Word increase 

after completing an introductory computer class? 

Participants 

The population for the study was one of convenience and consisted of 2,180 students 

enrolled in 14 on-campus offerings of an introductory computer science course during the fall 

2009 semester. Participants were students in the population that voluntarily agreed to participate 

in the research study. Participants who chose to complete the precourse survey and the 

postcourse survey, as well as, the precourse proficiency exams and the postcourse proficiency 

exams were included in the final analysis. 

Instrumentation 

Survey Instrument 

According to Bandura (2006), there is no all-purpose measure of perceived self-efficacy. 

Bandura stated that to eliminate generalities and ambiguities, perceived self-efficacy scales must 

be tailored to the particular field of performance that is being studied. Because self-efficacy is 

concerned with perceived capability (Bandura, 2006), the survey items have been phrased in 

terms of “can do” because “can” is a judgment of capability. To ensure the construction of a 
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sound computer self-efficacy scale, an analysis of relevant tasks measured was conducted by 

cross-referencing skills from the Microsoft Certified Application Specialist (MCAS) exam 

(Appendix A) and skills taught and assessed in introductory computer courses on campus. Tasks 

were narrowed down by course instructors to 10 tasks per each Microsoft Office 2007 

application being assessed (Vista, Access, Excel, PowerPoint, and Word), totaling 50 tasks 

(Appendix B). Additionally, as instructed by Bandura’s Guide for Constructing Self-Efficacy 

Scales (2006), and suggested by Gist and Mitchell (1992), survey items included easy, medium, 

and difficult degrees of computing tasks in each specific computing subdomain. For each of the 

50 tasks, students were first asked whether or not they could complete a given task. Students 

indicated either “no” (cannot do at all) or indicated they could complete the task by marking on 

a scale of 10 to 100 how confident they were that they could complete the given task using a 

specific Office 2007 application. This survey instrument used a 100-point response format (“No” 

= cannot do at all, 50 = moderately confident can do, 100 = highly confident can do) because 

doing so allows a stronger predictor of performance than a 1-5, or 0-10 scale (Pajares, Hartley, & 

Valiante, 2001), and it is also recommended by Bandura (2006). The instrument instructions 

asked participants to “please rate how confident you are that you can complete computer tasks 

described below using (specified application).”  

In addition to the rating scales for task-specific computing self-efficacy, the precourse 

survey (Appendix C) was also designed to collect information regarding demographics, 

technology training, and online computing. The postcourse survey (Appendix D) was a copy of 

the precourse survey minus the request for demographic, technology training, and online 

computing information because that information had previously been collected. The purpose of 

the postcourse survey was to gather student responses in order to analyze whether general 
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computer self-efficacy and task-specific computer self-efficacy changed after completing an 

introductory computing class. 

 Face validity of the survey instrument was established by having three instructors that 

teach introductory computer courses review the instrument prior to implementation. Prior to use 

in the study, a pilot group of 60 summer school students enrolled in CS102 took the survey to 

assess the readability of the instruments regarding instructions and survey questions. Based on 

the feedback and results of the pilot, changes were made to make the instructions easier to 

understand, and a typing error found was corrected. Construct validation was determined by 

pretesting students on a task-based performance exam using simulated Office 2007 software.  

In order to minimize response bias the survey was coded by number rather than by name. 

Respondents were informed that their responses would remain confidential and would be 

identified only with the number codes by the researcher. To encourage honest answers, the 

importance of the study was explained to students.  

Proficiency Assessment 

In addition to the pre- and postsurveys, participants were asked to complete a 

preproficiency assessment, as well as, a postproficiency assessment (Appendix B). The purpose 

of the precourse proficiency assessment was to evaluate the computer proficiency of students 

enrolled in CS102 prior to instruction taking place. The postcourse proficiency assessment was 

used to help determine the amount of growth that took place from the beginning to the end of the 

computer course. The pre- and postcourse proficiency exams were vital in answering Research 

Questions 3 and 5. The proficiency test used for the study was not the same instrument that was 

created and used for testing business students during the fall 2008 and spring 2009 semesters, but 

it was similar. The actual proficiency exam used at the University for proficiency testing is a 
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100-question assessment and is given in a 2-hour time frame. The instrument used in this study 

was only 50 questions in length (10 questions each for Vista, Access, Excel, PowerPoint, and 

Word) and could easily be completed within a 50-minute class meeting time.  

Data Collection 

Data were collected from pre- and postcourse survey responses and pre- and postcourse 

proficiency exams delivered as part of the course content. Student surveys were linked to the 

Resources page in the student side of SimNet. A link to Survey 1 and the precourse proficiency 

exam was available to students the first week of class. A link to Survey 2 and the postcourse 

proficiency exams were available to students the final week of class. Students received a 

message in their SimNet message center as a reminder of the availability of each survey and pre- 

and postexam. 

Data Analysis 

Data from the voluntary precourse and postcourse surveys were collected and stored 

online. Data collected via the online surveys provided general computer self-efficacy (GCSE) 

scores, as well as, task-specific self-efficacy (TCSE) scores for completing tasks using the Vista 

operating system and Microsoft Office 2007 applications Access, Excel, PowerPoint, and Word. 

Additional demographic information collected from the survey and used in data analysis 

included the number of computer courses taken in high school. All survey responses were 

exported to Microsoft Excel and then imported to Microsoft Access where they were matched to 

students’ precourse and postcourse proficiency exam scores using campus wide identification 

numbers. All data were then exported to Microsoft Excel, and campus wide identification 

numbers were deleted prior to being imported into SPSS 16.01. Each research question was then 

addressed. 
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Research Question 1 

Are general computer self-efficacy (GCSE) ratings higher than task-specific computer 

self-efficacy (TCSE) ratings? 

Research question 1 was examined by using self-efficacy data collected on the online 

precourse survey. A repeated measures ANOVA with six levels was used to examine differences 

between general computer self-efficacy (GCSE) scores and task-specific computer self-efficacy 

(TCSE) scores. The researcher utilized a Bonferroni post hoc adjustment to control for inflated 

Type I error rates and investigate specific differences among groups.  

Research Question 2 

Is there a relationship between number of computer classes taken in high school and 

general computer self-efficacy (GCSE)? 

 Research question 2 was examined by conducting a one-way ANOVA utilizing a Tukey 

post hoc test. The one-way ANOVA was used to determine whether or not one group of students 

reported higher self-efficacy scores than another group of students based on the number of 

computer classes taken in high school. 

Research Question 3 

Is there a relationship between task-specific computer self-efficacy (TCSE) and computer 

proficiency regarding completing computer tasks using the Vista operating system and Microsoft 

Office 2007 applications Access, Excel, PowerPoint, and Word? 

Research question 3 was addressed by conducting the Pearson Correlation Coefficient in 

SPSS to determine whether there is a linear relationship between task-specific computer self-

efficacy and computer proficiency in Vista and Microsoft Office 2007 applications Access, 

Excel, PowerPoint, and Word.  
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Research Question 4 

Does task-specific computer self-efficacy (TCSE) regarding completing computer tasks 

using Vista and Microsoft Office 2007 applications Access, Excel, PowerPoint (PPT), and Word 

increase after completing an introductory computer class?  

Research Question 4 was examined by entering collected survey data into SPSS 16.0 and 

conducting a paired-samples t test using the post self-efficacy score as the first variance and the 

pretest self-efficacy score as the second variance. All students rated themselves regarding task-

specific computing self-efficacy before taking an introductory computer class and after taking an 

introductory computer class. The mean difference between the specific computing self-efficacy 

ratings before taking an introductory computer class and after taking a introductory computer 

class were examined for statistically significant gains in confidence levels. This assisted in 

answering whether or not TCSE regarding completing computer tasks using Vista and Microsoft 

Office 2007 applications Access, Excel, PPT, and Word increased after completing an 

introductory computer class. 

Research Question 5 

Does computer proficiency regarding completing computer tasks using Vista and 

Microsoft Office 2007 applications Access, Excel, PowerPoint, and Word increase after 

completing an introductory computer class? 

Research Question 5 was addressed by entering collected pretest and posttest proficiency 

exam scores into SPSS 16.0 and conducting a paired-samples t test using posttest score as the 

first variance and the pretest score as the second variance in order to compare computer 

proficiency before and after taking an introductory computer course. As part of the course 

requirements for CS102 courses offered in the fall 2009 semester, all students were assigned to 
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take the precourse proficiency exam the first week of class in an introductory computer class. At 

the end of the semester, all students were assigned to take the postcourse proficiency exam. 

Summary 

Data were collected for this study via surveys and exam scores. Students enrolled in 

introductory computer classes voluntarily completed a survey the first week of class and also 

completed precourse proficiency exams. Students then completed a semester long computer 

applications course. Training and assessment was delivered through a competency based training 

product titled, SimNet for Office 2007. At the end of the semester, students voluntarily 

completed postcourse surveys and postcourse proficiency exams. Following data collection and 

analysis, findings were reported in subsequent discussions. Conclusions were drawn, and 

recommendations for further study were shared in chapters 4 and 5. 
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CHAPTER 4 

RESULTS 

Summary of Study 

The purpose of this study was to explore the relationship between task-specific computer 

self-efficacy (TCSE) and computer proficiency regarding completion of tasks using the Vista 

operating system and Office 2007 applications Access, Excel, PowerPoint, and Word. Self-

efficacy theory (SET) states that self-efficacy is a reliable indicator of performance 

(Bandura,1977), however recent research assessing computer self-efficacy and computer 

performance has found that computer self-efficacy ratings are often higher than performance 

scores (Grant et al., 2009; Smith, 2001). This study also examined whether students enrolling in 

the introductory course CS102 were already computer proficient. Additionally, this study sought 

to determine whether computer self-efficacy and performance increase after completing an 

introductory college-level computer course, and whether data indicate that there is still a need to 

offer introductory computer courses at the college level.  

Instrumentation 

Survey Instrument 

Following Bandura’s (2006) guidelines, a pre- and postcourse computer self-efficacy 

survey was developed to fit the field of performance being studied. Students were asked to rate 

themselves on a scale ranging from 10 to 100 regarding confidence levels associated with 

general computer self-efficacy, as well as task-specific computer self-efficacy. In addition to 

self-efficacy rating scales, the precourse survey (Appendix C) was designed to collect 



 

49 

information regarding demographics, technology training, and online computing information. 

The postcourse survey (Appendix D) was a copy of the precourse survey minus the request for 

demographic, technology training, and online computing information because that information 

had previously been collected. The purpose of the postcourse survey was to gather student self-

efficacy ratings for general computing and task-specific computing, after completing an 

introductory computer course, in order to analyze whether general computer self-efficacy and 

task-specific self-efficacy changed.  

Pre- and Postproficiency Exams 

During the first week of class meetings, prior to any content instruction but after taking 

the precourse survey, students were assigned to take five 10-question precourse proficiency  

exams (Appendix  B) using SimNet software. Each exam measured the ability to perform the 

tasks listed on the precourse surveys. The surveys provided a task-based self-efficacy score, and 

the precourse proficiency exams provided a task-based proficiency score for comparison. During 

the final week of class, students were asked to take the postcourse survey and once again provide 

self-efficacy ratings for both general and task-based computing abilities. After that, students 

were instructed to complete the same five proficiency exams. Pre- and postproficiency exam 

scores were used along with the pre- and postcourse self-efficacy ratings to address the research 

questions in this study. 

Sample 

The population for this study consisted of college students enrolled in 14 sections of an 

introductory computer class at one large southeastern university. Course enrollment equaled 

2,180 students at the beginning of the semester. The precourse survey was voluntarily attempted 

by 2,061 students. Some students (n = 70) that began the survey chose the option not to 
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participate in the study. Of those remaining, over 96% (n = 1,984) agreed to complete the survey, 

but only 90% of those students (n = 1,782) completed the survey. At the end of the semester, 

class enrollment was 2,101. The enrollment decreased because 41 students withdrew from the 

class, 74 students remained enrolled, but did not finish the class, and 38 enrolled students made 

no effort to attend or participate in the class. The postcourse survey was attempted by 1,466 

students and successfully completed by 97.8% (n = 1,434).  

Students also took five precourse and five postcourse proficiency exams. Varying 

numbers of students completed each exam (Table 1). 

Table 1 

Completed Proficiency Exams 

Application Precourse Exam Postcourse Exam 

Vista 1494 1302 

Access 1261 1180 

Excel 1250 1204 

PowerPoint 1258 1221 

Word 1313 1234 
 

Demographic Data 

Respondents were asked on the pretest survey (Appendix C) to provide demographic data 

that included the following: campus wide identification number, gender, student classification, 

ethnic background, geographical location of the high school attended, number of computer 

classes taken in high school, what they spend time on the computer doing, and average amount 

of time spent daily on the computer, as well as, whether or not they attempted a computer 
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proficiency placement exam prior to enrolling in an introductory computer class. No additional 

demographic information was collected on the postcourse survey (Appendix D). 

Responses to the precourse survey totaled 1,782 (53% females, 44.4% males, 2.6% 

unknown). Because computer use and time spent on a computer have been found to increase 

one’s computer self-efficacy (Hill et al., 1987), as part of the demographic information collected, 

respondents were asked on average how much time a day was spent on a computer, as well as, 

what they spent that time on a computer doing. The majority of respondents indicated that they 

spent 3-4 hours a day on a computer (Table 2). The most popular uses of computer time were 

visiting social networking sites such as Facebook and MySpace, completing/submitting 

homework, shopping, and utilizing email.  

Table 2 

Average Daily Computer Use 

Hrs. a Day spent on 
Computer 

   
  N 

 
% 

0-2 hrs 680 38.2% 

3-4 hrs 751 42.1% 

5-6 hrs 214 12.0% 

7-8 hrs 53 3.1% 

9-10 hrs 6 .3% 

> 10 hrs 13 .7% 

No Response indicated 65 3.6% 

 

In addition to computer use and time spent on a computer, computer training has also 

been found to increase computer self-efficacy (Bandura, 1986). The majority of survey 

respondents (75.9%) indicated that they were required to take a computer class in high school, 
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and 80.7% reported that their high school offered computer courses as electives. Data were also 

collected regarding types of computer instruction students had in high school (Table 3). 

Table 3 

High School Computer Instruction 

Topics    N    % 

Keyboarding 1356 76.1% 

Presentation Software 1304 73.2% 

Word Processing 1250 70.1% 

Spreadsheets 1039 58.3% 

Databases 529 29.7% 

Web Design 418 23.5% 

Basic Programming 424 23.0% 

Networking 208 11.7% 

 

 All students enrolled in the 14 sections of the introductory computer class had the 

opportunity to take a proficiency exam to test out of the introductory computer course. 

Respondents were asked to indicate whether or not they took the proficiency exam. Only 62 

respondents (3.5%) attempted to test out of the course. Respondents who indicated they did not 

attempt the proficiency exam to place out of the course were then asked to specify whether or not 

they believed they could have passed the proficiency exam had they chosen to take the exam. 

Seventy-one percent of students who did not attempt the proficiency exam responded that they 

believed they could have passed the exam. 
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Data Analysis 

Research Question 1: Are general computer self-efficacy (GCSE) ratings higher than 

task-specific computer self-efficacy (TCSE) ratings? 

To address Research Question 1, students voluntarily completed a precourse survey 

(Appendix C). Item 4 on the precourse survey requested that students rate, on a 10-point scale, 

how confident they were regarding their personal capabilities (at that time) to use a computer to 

complete various tasks. These ratings were used to determine general computer self-efficacy. 

Items 10-14 directed students to ask themselves whether they could complete specific tasks using 

a given Microsoft Office 2007 application. There were ten tasks of varied difficulty for each of 

the five applications. Students were to select the option marked “no” if they could not do the 

task, or to indicate on a 10-point scale how confident they were that they could complete the 

computer task described. The 10 ratings for each application were averaged and used to establish 

task-specific computer self-efficacy for each student (Table 4). For data analysis, only surveys 

without missing responses in sections 10-14 were considered. 

Table 4  

Descriptive Statistics of Within-Subjects Factors 

SE Type   M    SD    n 

GCSE 
 

69.46 19.503 1577 

TCSE-Word 
 

75.51 20.643 1577 

TCSE-Vista 
 

74.68 21.339 1577 

TCSE- PPT 
 

70.54 26.011 1577 

TCSE-Excel 
 

59.89 27.175 1577 

TCSE-Access 43.42 32.259 1577 
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An ANOVA using a repeated-measures design was used to analyze the data for this 

question. Mauchly’s test indicated that the assumption of sphericity had been violated (χ2 (14) = 

1528.499, p < .05), therefore degrees of freedom were corrected using Huynh-Feldt estimates of 

sphericity (ε = .698). The results indicated a significant effect between GCSE and TSCE, 

F(3.492, 5503.565) = 862.897, p = .000). Because a significant difference between GCSE ratings 

and TCSE ratings was found, the initial analysis was followed up with between-group post hoc 

tests (Table 5) to examine differences between GCSE and specific task based self-efficacy 

ratings. The significance values of the between-group post hoc tests indicate that all groups have 

significant differences between group means except for the task-specific self-efficacy score for 

PowerPoint and the proficiency scores for PowerPoint.  

Table 5 

Bonferroni Comparisons of General Computer Self-Efficacy (GCSE) to Task-Specific 
Computer Self-Efficacy (TCSE) 
 

   95% Confidence 
Interval 

Comparisons Mean SE 
Score Diff. 

 
Std Error 

Lower 
Bound 

Upper 
Bound 

GSCE vs. Word SE -6.044* .504 -7.525 -4.563 

GSCE vs. Vista OS SE -5.224* .490 -6.663 -3.784 

GSCE vs. PowerPoint SE -1.076 .583 -2.791    .639 

GSCE vs. Excel SE 9.575* .615 7.767 11.382 

GSCE vs. Access 26.036* .490 23.704 28.368 

*p < 0.05. 
 

Research Question 2: Is there a relationship between number of computer classes taken in 

high school and general computer self-efficacy (GCSE)? 
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To address Research Question 2, responses to Items 4 and 8 on the precourse survey were 

used. Item 4 provided the GCSE rating used in Research Question 1. Item 8 on the precourse 

survey requested that students indicate how many computer classes they had taken in high 

school. Although survey answer choices were 0, 1, 2, 3, 4, 5, and more than 5, for the purposes 

of data analysis, responses were coded based on the range of answers as “1” (0 classes), “2” (1-2 

classes) and “3” (3-5 classes) (Table 6). Collected data were entered into SPSS and an ANOVA 

was conducted. 

Table 6 

Computer Classes Taken in High School 

Number of  Classes n %  

0    231 13.7  

1-2 1,264 75.2  

  3-5+    186 11.1  

 

The ANOVA found that a significant difference did exist, F(2, 1677) = 8.973, p = .000 

(Table 7). A Tukey post hoc test found that the differences were between those who had taken 

three or more computer classes in high school, and those who had taken 1 or 2 classes, and those 

who had not taken any computer classes in high school (Table 8). Students who took three or 

more computer classes in high school reported higher levels of general computing self-efficacy. 
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Table 7 

Summary of ANOVA 

 Sum of 
Squares        df Mean 

Squares F 

Between Groups 6879.956 2 3439.978 8.973  

Within Groups 642876.234 1677 383.349  

Total 649756.190 1679    

*p < 0.05 

 

Table 8 

Tukey HSD Comparison for Number of Computer Classes Taken in High School and GCSE 

   95% Confidence Interval 

Comparisons Mean GCSE 
Score 

SD Lower Upper 

0 Classes vs. 3 or More  -7.881* 1.929 -12.41 -3.36 

1 or 2 Classes vs. 3 or More -5.604* 1.538  -9.21  -2.00 

0 Classes vs. 1 or 2 Classes  -2.277  1.401  -5.56    1.01  

*p < 0.05.     

Research Question 3: Is there a relationship between task-specific computer self-efficacy 

(TCSE) and computer proficiency regarding completing computer tasks using the Vista  

operating system and Microsoft Office 2007 applications Access, Excel, PowerPoint, and Word? 

To address Research Question 3, Items 10-14 on the precourse survey (Appendix C) and 

scores from the five individual precourse proficiency exams (Appendix B) were utilized. As 
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previously stated, the week prior to the first class meeting of an introductory computer class in 

the fall of 2009, students enrolled in 14 on-campus sections of the course had the opportunity to 

voluntarily complete an online survey. One section of the survey was designed to collect 

students’ task-specific self-efficacy levels regarding how confident they were that they would be 

able to complete task-specific commands using the Vista operating system and Microsoft Office 

2007 applications Access, Excel, PowerPoint, and Word. Students were asked to indicate 

whether they could complete the task, and, if so, to what confidence level on a 100-point scale (0 

= cannot do, 50 = moderately confident, and 100 = highly confident). Students were asked to rate 

themselves on 10 Vista tasks, 10 Access tasks, 10 Excel tasks, 10 PowerPoint tasks, and 10 

Word tasks.  

The first week of class, as part of the course content, students were asked to complete 

five precourse proficiency assessments, covering the Vista operating system and Microsoft 

Office 2007 applications Access, Excel, PowerPoint, and Word. Each assessment contained 10 

tasks to be completed in a simulated computer environment using the competency-based SimNet 

for Office 2007 software. The 10 tasks on each assessment were the same 10 tasks addressed on 

the precourse survey.  

Students’ task-specific self-efficacy scores from the precourse survey and students’ 

precourse proficiency assessment scores were entered into SPSS statistical software, and Pearson 

Correlations were run for student self-efficacy scores and student proficiency scores for topics  

Vista, Access, Excel, PowerPoint, and Word. A significant, but weak positive correlation was 

found in all five instances: task-specific computer self-efficacy and proficiency scores using 

Vista (r = .216, p = .000), task-specific computer self-efficacy and proficiency scores using 

Access (r = .008, p = .008), task-specific computer self-efficacy and proficiency using Excel (r = 
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.173, p = .000), task-specific computer self-efficacy and proficiency scores using PowerPoint (r 

= .212, p = .000),  and task-specific computer self-efficacy and proficiency scores using Word (r 

= .177, p = .000). Based on these results, there is a weak, positive correlation between TCSE and 

computer proficiency regarding completing computer tasks using the Vista operating system and 

Microsoft Office 2007 applications Access, Excel, PPT, and Word. All task-specific self-efficacy 

scores were higher than actual task-specific proficiency scores. Task-specific computer self-

efficacy ratings possess little predictive ability for task-specific computer proficiency scores. 

Research Question 4: Does task-specific computer self-efficacy (TCSE) regarding 

completing computer tasks using Vista and Microsoft Office 2007 applications Access, Excel, 

PowerPoint, and Word increase after completing an introductory computer class? 

To address Research Question 4 data were collected from Items 10-14 on the precourse 

survey (Appendix C) and Items 4-8 on the postcourse survey (Appendix D). Data were then 

entered into the SPSS software, and a paired-samples t test, also known as the t test for 

dependent means or the dependent t test, was run to determine whether the means of each pair of 

matched scores for precourse GCSE scores and postcourse GCSE significantly differ from each 

other (Table 79). Strength of the relationship was determined by calculating Cohen’s d by 

dividing the mean difference of each pair by the standard deviation. The GCSE increased from 

69.69 (sd = 19.215) on the precourse survey to a mean of 81.91 (sd = 14.702) on the postcourse 

survey. The difference between the two means was statistically significant at the .05 level, 

t(1167) = 22.737, p = .000, d = .665. General computer self-efficacy increased after completing 

an introductory computing class. Based on Cohen’s criteria, the d value indicates a medium 

effect size. 
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Paired samples t tests were also run to determine whether the means of each pair of 

matched scores for precourse TCSE scores and postcourse TCSE scores for computer tasks using 

the Vista operating system and Microsoft Office 2007 applications Access, Excel, PPT, and 

Word significantly differ from each other (Table 10). Differences between means are statistically 

significant at the 0.05 level, and Cohen’s d was calculated by dividing the mean difference of 

each pair by the standard deviation of each pair. The mean task-specific self-efficacy score for 

the Vista operating system increased from 74.36 (sd = 21.421) on the precourse survey to a mean 

of  94.27 (sd = 10.141) on the postcourse survey. The difference between the two means was 

statistically significant, t(1123) = 31.972, p = .000  d = .953. The mean task-specific self-efficacy 

score for the Microsoft Access increased from 44.12 (sd = 32.110) on the precourse survey to 

91.06 (sd = 14.230) on the postcourse survey. The difference between the two means was 

statistically significant, t(1094) = 47.117,  p = .000, d  = 1.423. The mean task-specific self-

efficacy score for Microsoft Excel increased from 59.86 (sd = 27.277) on the precourse survey to 

90.37 (sd = 13.141) on the postcourse survey. The difference between the two means was 

statistically significant, t(1104) = 37.635, p = .000, d = 1.13. The mean task-specific self-efficacy 

score for Microsoft PPT increased from 71.27 (sd = 25.010) on the precourse survey to 96.14 (sd 

= 8.927) on the postcourse survey. The difference between the two means was statistically 

significant, t(1080) = 32.621, p = .000, d = .992. The mean task-specific self-efficacy score for 

Microsoft Word increased from 75.57 (sd = 20.313) on the precourse survey to 95.17 (sd = 

9.376) on the postcourse survey. The difference between the two means was statistically 

significant, t(1114) = 32.223, p = .000, d = .938. Task-specific self-efficacy regarding 

completing tasks using the Vista operating system and Microsoft Office 2007 applications 
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Access, Excel, PPT, and Word increased after completing an introductory computing class. The 

effect size for all pairs was considered to be large, with Cohen’s d being greater than .8. 

Table 9 

Paired-Samples Statistics for Pre- and Postcourse Self-Efficacy Scores 

Pair Pre & Post TCSE N M SD Std. Error 
Mean 

1 Post Access SE 

Pre Access SE 

1095 

1095 

91.06 

44.12 

14.230 

32.110 

.430 

.970 

2 Post Excel SE 

Pre Excel SE 

1105 

1105 

90.37 

59.86 

13.141 

27.277 

.395 

.560 

3 Post PPT SE 

Pre PPT SE 

1081 

1081 

96.14 

71.27 

  8.927 

25.010 

.272 

.761 

4 Post Word SE 

Pre Word SE 

1115 

1115 

95.17 

75.57 

  9.376 

20.313 

.281 

.608 

5 Post Vista SE. 

Pre Vista SE 

1124 

1124 

94.27 

74.36 

10.141 

21.420 

302 

.639 

6 Post GSCE 

Pre GSCE 

1168 

1168 

81.91 

69.69 

14.702 

19.215 

.430 

.562 
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Table 10 

Paired-Samples Test for Pre- and Postcourse Self-Efficacy Scores 

      95% Confidence 
Interval 

Paired Samples t value df 2-tailed 
Sig 

Effect 
Size 

SE of 
Diff 

Lower 
Bound 

Upper 
Bound 

PostAccessSE - 

PreAccessSE 
47.117 1094 .000 1.423 .996 44.981 48.890 

PostExcelSE - 

PreExcelSE 
37.635 1104 .000 1.132 .811 28.922 32.104 

PostPPTSE - 

PrePPTSE 
32.621 1080 .000 .992 .762 23.373 26.365 

PostWordSE - 

PreWordSE 
32.223 1114 .000 .938 .608 18.404 20.791 

PostVistaSE - 

PreVistaSE 
31.972 1123 .000 .953 .623 18.687 21.130 

PostGCSE – 

PreGCSE 
22.737 1167 .000 .665 .537 11.163 13.272 

p < .05.        

 

Research Question 5: Does computer proficiency regarding completing computer tasks 

using Vista and Microsoft Office 2007 applications Access, Excel, PowerPoint, and Word 

increase after completing an introductory computer class?  

Paired samples t tests were also run to determine whether the means of each pair of 

matched scores for precourse task-specific proficiency scores and postcourse proficiency scores 

for computer tasks using the Vista operating system and Microsoft Office 2007 applications 
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Access, Excel, PowerPoint, and Word significantly differ from each other (Table 11). 

Differences between means were statistically significant at the 0.05 level, and Cohen’s d was 

calculated by dividing the mean difference of each pair by the standard deviation of each pair. 

The mean task-specific proficiency score for the Vista operating system increased from 48.35 (sd 

= 22.625) on the Vista pretest to 68.63 (sd = 17.212) on the Vista posttest. The difference 

between the two means was statistically significant, t(1007) = 26.735, p = .000  d = .842. The 

mean task-specific proficiency score for Microsoft Access increased from 35.12 (sd = 24.316) on 

the Access pretest to a mean of 80.49 (sd = 18.231) on the Access posttest. The difference of the 

two means was statistically significant, t(794) = 49.866, p = .000, d  = 1.768. The mean task-

specific proficiency score for Microsoft Excel increased from 27.10 (sd = 15.910) on the Excel 

pretest to 54.35 (sd = 16.470) on the Excel posttest. The difference between the two means was 

statistically significant, t(806) = 41.319, p = .000, d = 1.454. The mean task-specific proficiency 

score for Microsoft PPT increased from 52.64 (sd = 31.220) on the pretest to 95.17 (sd  = 

10.659) on the PPT posttest. The difference between the two means was statistically significant, 

t(817) = 39.745, p = .000, d = 1.389. The mean task-specific proficiency score for Microsoft 

Word increased from 32.26 (sd = 21.009) on the Word pretest to 69.03 (sd = 17.545) on the 

Word posttest. The difference between the two means was statistically significant, t(856) = 

49.439, p = .000, d = 1.688 (Table 12). Task-specific computer proficiency regarding completing 

tasks using the Vista operating system and Microsoft Office 2007 applications Access, Excel, 

PPT, and Word increased after completing an introductory computing class. The effect size for 

all pairs was considered to be large, with Cohen’ s d being greater than .8. 
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Table 11 

Paired-Samples Statistics for Pre- and Postcourse Proficiency Scores 

Pair Pre- and Post- 
Proficiency N M SD Std. Error 

Mean 

1   Posttest Access 

Pretest Access 

795 80.49 

35.12 

18.231 

24.316 

.647 

.862 795 

2 Posttest Excel 

Pretest Excel 

807 

807 

54.35 

27.10 

16.470 

15.910 

.580 

.560 

3 Posttest PPT 

Pretest PPT 

818 

818 

95.17 

52.64 

10.659 

31.220 

.373 

       1.092 

4 Posttest Word 

Pretest Word 

857 

857 

69.03 

32.26 

17.545 

21.009 

.599 

.718 

5 Posttest Vista 

Pretest Vista 

      1008 

      1008 

68.63 

48.35 

17.212 

22.625 

.542 

.713 
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Table 12 

Paired Samples Test for Pre and Posttest Proficiency Scores 

      95% Confidence 
Interval 

Paired Samples t value df 2-tail 
Sig 

Effect 
Size 

SE of 
Diff 

Lower 
Bound 

Upper 
Bound 

Posttest Access - 

Pretest Access 
49.866 794 .000 1.768 .910 43.585 47.157 

Posttest Excel - 

Pretest Excel 
41.319 806 .000 1.454 .659 25.995 28.544 

Posttest PPT - 

Pretest PPT 
39.745 817 .000 1.389   1.070 40.430 44.631 

Posttest Word - 

Pretest Word 
49.439 856 .000 1.688 .744 35.308 38.227 

Posttest Vista - 

Pretest Vista 
26.735   1007 .000   .842 .758 18.789 21.766 

p < .05. 

Summary 

In summary, this chapter presented data analyses and findings for each research question 

presented in this study. The results provide insight into the relationship between computer self-

efficacy and proficiency before and after taking an introductory college-level computing course. 
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CHAPTER 5 

DISCUSSION, IMPLICATIONS, AND RECOMMENDATIONS 

Introduction 

Research has documented the importance of college-bound individuals possessing basic 

computer skills related to word processing, spreadsheets, presentation software, and computer 

concepts (Hardy, 2005; Hulick & Valentine, 2008; Wilkinson, 2006; Wolk, 2008). 

Documentation also exists that indicates that although students should be exposed to and taught 

these skills during their high school years, computer courses in high school are often only offered 

as elective courses (Ceccucci, 2006). Based on proficiency testing scores, the majority of 

students entering college are not passing skill-based computer literacy exams (Coolbaugh, 2004; 

Hardy, 2005; Hulick & Valentine, 2008; Rafaill & Peach, 2001; Shannon, 2008; Templeton et 

al., 2003; VanLengen, 2007; Wallace & Clariana, 2005), although they appear to be self-

confident regarding their computer skills. The purpose of this study was to explore the 

relationship between task-specific computer self-efficacy (TCSE) and computer proficiency 

regarding completion of tasks using the Vista operating system and Office 2007 applications 

Access, Excel, PowerPoint, and Word. Additionally, self-efficacy theory (SET) states that self-

efficacy is a reliable indicator of performance (Bandura, 1977), however recent research 

assessing computer self-efficacy and computer performance has found that computer self-

efficacy ratings are often higher than performance scores (Grant et al., 2009 ; Shannon, 2008;  

Smith, 2001). This study also examined whether students enrolling in the introductory course 

CS102 were already computer proficient. Furthermore, this study sought to determine whether 
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computer self-efficacy and performance increased after completing an introductory college-level 

computer course, and whether data indicated that there is still a need to offer introductory 

computer courses at the college level.  

Demographic Findings 

Demographic information collected from the precourse survey indicated that the majority 

of students participating in this study spent 3 or more hours a day online. Popular uses of online 

time included visiting social networking sites, utilizing email, shopping, and completing/ 

submitting homework. Responses indicated that 75.9% of the participants were required to take a 

computer class in high school. Computer courses were offered as elective classes in 80.7% of the 

respondents’ high schools. All students enrolled in CS102 had the opportunity to attempt placing 

out of the course by taking a free proficiency exam.  Ninety-six percent of survey respondents 

indicated they chose not to take the proficiency exam, even though 71% of them indicated they 

believed they would have been able to pass the exam. 

Findings 

Research Question 1:  Are general computer self-efficacy (GCSE) ratings higher than 

task-specific computer self-efficacy (TCSE) ratings? 

Recent research shows a trend of Generation Y students arriving on campus with high 

levels of computer self-efficacy (Considine et al., 2009; Imhof et al., 2007; Lahore, 2008; 

Shannon, 2008; Wilkinson, 2006). GCSE assesses an individual’s computer self-efficacy for all 

computing domains, whereas TCSE assesses individual computer self-efficacy within 

subdomains (Downey & McMurtrey, 2007; Marakas et al., 1998; Stephens, 2006). Because 

general self-efficacy develops over time and is a collection of experiences (Bandura, 1977), it 
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would be reasonable to think that GCSE ratings would be higher than TCSE ratings for 

Generation Y students based on the idea they have been raised in a “digital world.” 

During the first week of an introductory computing course, students were asked to 

complete a precourse survey to gather GCSE ratings, as well as TCSE ratings for completing 

tasks using the Vista operating system, Access, Excel, PPT, and Word. The mean GCSE score 

(M = 69.46) was compared to the mean TCSE score (M = 64.808). Initial tests of within-subjects 

found a significant difference between GSCE and TCSE ratings. Because the main effect was 

significant, pairwise comparisons were made to analyze the differences of means of GCSE 

ratings and task-specific computer self-efficacy ratings by topic (Vista operating system, Access, 

Excel, PPT, and Word). Significant differences were found in all pairwise comparisons except 

GCSE ratings and TSCE rating for using Microsoft PowerPoint (M = 70.54). 

GCSE ratings were significantly higher than TCSE ratings for Access (M = 43.42) and 

Excel (M = 59.89), implying that students were less confident about their ability to complete 

computing tasks using Microsoft Access and Excel. This is reasonable based on the 

demographics of this group of participants. Only 58.3% had indicated they had taken computer 

classes that taught spreadsheets, and an even lower number (29.7%) acknowledged taking a class 

that taught databases. On the other hand, 70.1% (n = 1,250) of the participants had taken classes 

in which word processing was taught, and TSCE ratings for completing tasks using the Vista 

operating system Microsoft Word were significantly higher than GCSE ratings. Results from this 

study indicated that students are confident in their skills using the Vista operating system and 

Microsoft Word. No significant differences between GCSE and TSCE for PowerPoint were 

found. 
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Research Question 2:  Is there a relationship between number of computer classes taken 

in high school and general computer self-efficacy (GCSE)? 

The third question in section 8 of the precourse survey asked students, “How many 

computer classes did you take in High School?” Answer choices included 0, 1, 2, 3, 4, 5, and 

more than 5. For the purposes of data analysis, responses were coded based on the range of 

answers as “1” (0 classes), “2” (1-2 classes) and “3” (3-5 classes). To test whether a relationship 

existed between the number of computer classes taken in high school and GCSE scores, an 

ANOVA was conducted. No significant difference was found between students that did not take 

any computer classes in high school and those that took one or two classes. There was a 

significant difference between GCSE ratings of those taking three or more computer classes and 

those that took one or two, or no computer courses in high school. These findings are consistent 

with Havelka’s (2003) findings. Havelka stated that the number of computer courses taken in 

high school appeared to have a relationship with computer self-efficacy. He found significant 

differences between those with greater than three computer courses and those students with only 

one or two courses.  

These finding are important because although many high schools offer some type of 

computer application class, only about 13% of high schools require students to take a semester or 

more of computer applications courses (Ceccucci, 2006). Only 11.1% of students participating in 

this study reported taking three or more computing classes in high school. If computer self-

efficacy does not significantly increase until after three or more computing classes (Havelka, 

2003), then secondary schools should be persuaded to re-evaluate technology standards and be 

encouraged to incorporate more technology skills across the curriculum. 
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Research Question 3: Is there a relationship between task-specific computer self-efficacy 

(TCSE) and computer proficiency regarding completing computer tasks using the Vista 

operating system and Microsoft Office applications Access, Excel, PowerPoint, and Word? 

Self-efficacy theory (Bandura, 1977) states, and multiple research studies have 

concluded, that self-efficacy is a significant predictor of subsequent task-specific performance 

(Marakas et al., 1998). To test whether a relationship exists between TCSE and computer 

proficiency, students completed the TCSE rating scale on the precourse survey. The scale was 

designed to collect students’ task-specific computer self-efficacy ratings for 50 specific 

computing tasks (10 each for Vista, Access, Excel, PowerPoint, and Word). During the first 

week of the introductory computing course, students were assigned to complete a precourse 

proficiency assessment instructing students to perform the same 50 tasks as listed on the 

precourse survey. The Pearson Correlation results indicate that the answer to this research 

question was “yes,” there was a positive, but very weak relationship between TCSE and 

computer proficiency regarding completing computer tasks using the Vista operating system and 

Microsoft Office 2007 applications Access, Excel, PowerPoint, and Word. Although 

relationships were significant, r values were much closer to 0 than 1, suggesting that higher 

TCSE ratings did not translate into higher proficiency scores and lower TCSE ratings did not 

render lower proficiency scores.  

It was not surprising to see that average TCSE ratings were higher than average 

proficiency scores. These findings were consistent with Smith’s (2001) conclusion that students’ 

perceived ability to complete computing tasks surpassed performance. Findings differed slightly 

from those of Grant et al. (2009) that similarly found significant differences between CSE and 
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spreadsheet and database performance, but not much difference in word processing and 

presentation performance. 

Research Question 4: Does task-specific computer self-efficacy (TCSE) regarding 

completing computer tasks using Vista and Microsoft Office 2007 applications Access, Excel, 

PowerPoint, and Word increase after completing an introductory computer class? 

Self-efficacy theorist Albert Bandura stated that training increases levels of self-efficacy 

(Bandura, 1986). To address Research Question 4, students enrolled in introductory computer 

classes completed TCSE surveys both at the beginning and end of the semester. Approximately 2 

weeks were spent in training for each application using SimNet for Office 2007 software 

between surveys. Pre- and postcourse ratings were used for paired-sample tests. Results from this 

study found significant differences between pre- and postcourse TCSE ratings. TCSE increased 

by an average of 50% after training took place. The largest gains were seen in Access and Excel 

ratings.  

Research Question 5:  Does computer proficiency regarding completing computer tasks 

using Vista and Microsoft Office 2007 applications Access, Excel, PowerPoint, and Word 

increase after completing an introductory computer class? 

To address Research Question number 5, precourse proficiency assessment scores 

obtained at the beginning of the semester and the postcourse proficiency scores gathered at the 

end of the semester were used to run paired-samples correlations. Significant gains were made in 

all task-specific areas. Completing an introductory computer class does increase computer 

proficiency. The largest gains were made in the areas of Access, Excel, and Word, where the 

mean class average more than doubled. It is important to remember the training and postcourse 

proficiency exam took place within a 3-month period. It may be easier to remember information 
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soon after instruction has taken place. It would be interesting to follow up with the proficiency 

exam a full year or more later to make sure the skills had been retained.  

Discussion 

There is no doubt that today’s youth are being raised in a world immersed in various 

technologies. It is understandable that many would assume that today’s youth are computer 

proficient and possess the computer skills necessary to be successful in college. Skills involving 

word processing, spreadsheet, database, and presentation software are skills that research has 

documented as being important for college-bound students to possess (Hardy, 2005; Hulick & 

Valentine, 2008; Wilkinson, 2006; Wolk, 2008). However, the reality is that research indicates 

that the majority of incoming college students are unable to pass basic computer proficiency 

exams (Coolbaugh, 2004; Hardy, 2005; Hulick & Valentine, 2008; Rafaill & Peach, 2001; 

Shannon, 2008; Templeton et al., 2003; VanLengen, 2007; Wallace & Clariana, 2005).  

Today’s students do spend a lot of time using a computer. Fifty-eight percent of students 

in this study reported spending 3 of more hours a day on a computer engaged in some activity. 

Social networking sites such as Facebook and MySpace top the list of online use, with 91.6% of 

the respondents reporting they visit such sites while online. Other popular responses included 

downloading music (78%), editing and uploading photos (68.5%), and shopping (66%). Shannon 

(2008) pointed out that these are not the types of skills required in college or the business setting; 

however, such use of technology can lead to increased levels of self-efficacy regarding one’s 

own computing abilities (Considine et al., 2009; Imhof et al., 2007; Wilkinson, 2006). In 

addition to personal use, 76% of the students in this study reported taking at least one computer 

course in high school. All computer use, personal and instructional, combined with the number 
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of years of experience using a computer may increase a student’s confidence level (or self-

efficacy) regarding completing basic computer tasks. 

In order to assess GCSE and TCSE for the Vista operating system, Access, Excel, 

PowerPoint, and Word, students in this study took a precourse survey that asked students to rate 

their confidence level on a 100-point scale regarding using a computer in general and regarding 

their ability to complete specific given tasks using Office 2007 applications. Students then 

completed a precourse proficiency exam where they actually had to perform the skills they rated 

themselves on when taking the precourse survey. Similar to the findings of Grant et al. (2009) 

and Smith (2001), computer self-efficacy ratings, both general and task specific, were 

significantly higher than performance scores. Multiple research studies have concluded that self-

efficacy is a significant predictor of subsequent task-specific performance (Marakas et al., 1998); 

however, this study found no predictive ability between GSCE or TCSE ratings and task-specific 

performance. Perhaps the discrepancies in the findings were partly due to the fact that much of 

the research conducted on self-efficacy and academic performance were done in the areas of 

science and mathematics (Pajares, 1996). Self-efficacy studies regarding computer self-efficacy 

and performance seem to be the topic of more recent studies, and findings do not seem to follow 

the traditional self-efficacy theory. Current studies, including this one, do follow traditional self-

efficacy theory in the sense that exposure to and successful use of computers does appear to 

increase computer self-efficacy. Results from this study show that both GCSE and TCSE 

significantly increased after completing an introductory computer class. The differences between 

earlier and later self-efficacy research lie in actual performance outcomes as evident by the 

current study. According to the findings in this study, computer performance results cannot be 

predicted by computer self-efficacy ratings. 
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In regard to training, findings from this study showed that computer training increased 

both GCSE and TCSE ratings. This was consistent with the findings of Gist et al. (1989) that 

training increases computer self-efficacy. Additionally, findings from this study indicate that 

training also increased proficiency scores. Results show significant gains between precourse 

proficiency exam scores and postcourse proficiency exam scores. These findings support earlier 

findings by VanLengen (2007) and Wallace and Clariana (2005), who reported increased 

computer proficiency after completing an introductory computing class.  

Results from this study indicate that training is an intricate part of increasing computer 

self-efficacy and computer proficiency. Perhaps students are not passing proficiency exams 

because they have not had the proper training. In Ceccucci’s 2006 review of secondary 

technology standards at more than 100 high schools across the country, many discrepancies in 

secondary technology education were identified. Ceccucci reported that only 13% of the schools 

she studied required students to take a semester or more of computing classes. Almost 76% of 

students participating in this study indicated that they were required to complete a computer 

course in high school. Students in this study also indicated that computer courses were offered as 

electives at 80.7% of their schools. This finding is slightly lower than the 99% indicated in 

Ceccucci’s report. It is important to keep in mind that Havelka (2003) reported that it took 

completing three computer courses to achieve effective levels of computer self-efficacy. Results 

from this study support Havelka’s findings that there is a significant relationship between the 

number of computer classes taken in high school and GCSE ratings. Students in this study that 

had completed three or more computing classes in high school had significantly different GCSE 

ratings when compared to students only completing one or two computing classes or those 

students who did not take a computer class. Since it may be unreasonable to recommend all 
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students take three semesters of computer classes while in high school; it is suggested that high 

schools work on integrating technology instruction across the curriculum to help ensure higher levels of 

computer self-efficacy. 

Although training has been established as essential, it is important to remember that what 

is taught during training is also vital. The majority of students in this study, 73.2% and 70%, 

respectively, replied that they had prior training in presentation software and word processing 

skills. Fewer students had instruction in spreadsheets (58.3%) and databases (29.7%). These 

findings mirror those of Grant et al. (2009) who found that few students were proficient in 

spreadsheets and databases, two of the skills identified as being indispensable to be successful in 

the college and business environment (Hardy, 2005; Wolk, 2008). Bartholomew’s 2004 faculty 

survey (as cited in Wolk, 2008) indicated that use of spreadsheets and databases were not highly 

reinforced at the post-secondary level. However, if working knowledge of spreadsheets and 

databases are desired in the workforce, then it is the responsibility of instructors to make sure 

these are the skills being taught in the classroom. 

In addition to what is being taught, how the material is taught is pertinent as well. 

Marakas et al. (1998) emphasized the importance of finding a relevant applicable training 

method regarding computer use. Students participating in this study were enrolled in a lab-based 

introductory computer class that utilized the competency-based training product SimNet for 

Office 2007. SimNet for Office 2007 and other products like it offer individualized competency-

based training and assessment for Office applications and computer concepts. After training with 

SimNet software for one semester, computer self-efficacy ratings and computer proficiency 

scores of students in the study increased by an average of 44% and 93.3%, respectively. 

Proficiency scores for Access, Excel, and Word more than doubled after a semester of training 

took place. Currently, not much empirical evidence exists regarding the effectiveness of 
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competency-based training products such as SimNet for Office 2007. Studies researching the 

effectiveness and uses of competency-based training and assessment products are needed.  

Evidence gathered from this study reaffirms the declarations of VanLengen (2007) and 

Ceccucci (2006), who stated how important and necessary introductory computer course 

offerings are at the postsecondary level. Many studies have identified that college-age students 

are unable to pass basic computer proficiency assessments (Coolbaugh, 2004; Hardy, 2005; 

Hulick & Valentine, 2008; Rafaill & Peach, 2001; Shannon, 2008; Templeton et al., 2003; 

VanLengen, 2007; Wallace & Clariana, 2005). Every student in the current study had the 

opportunity to take a computer proficiency exam to test out of the introductory class and enroll in 

the next level computer class. Only 62 students (3.5%) attempted the proficiency exam. This 

statistic supports Coolbaugh’s (2004) conclusion that even when students have the choice of 

taking a computer exam to meet computer proficiency requirements, the majority of students 

select to take an introductory computer course instead. Of the 96.5% (n = 1,720) in this study 

who chose not to take the CS102 proficiency exam, 71.7% (n = 1,681) of the students indicated 

that they believed they could have passed the exam. Based on results of the precourse 

proficiency exams, only 1% (n = 18) would have actually been able to pass the University’s 

official microcomputers placement exam with a score of 76% or above. These findings come at a 

time when many colleges are considering or have already eliminated introductory courses due to 

the 120-Hour Rule and the assumption that Net Generation youth already possess these skills 

(Shannon, 2008; Templeton et al., 2003). Data from this study should be used as an incentive for 

colleges and universities to reconsider decisions regarding discontinuing introductory computer 

offerings. 
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Implications 

 Results from this study imply that college administrators need to recognize the need for 

introductory computer classes. With so many students unable to pass basic proficiency exams, 

now is not the time to eliminate introductory computer course offerings. Additionally, college 

administrators should communicate with their business partners and/or businesses that recruit on 

their campuses and identify the computer skills most desired in the work force. Administrators 

then need to communicate such information to instructors on campus who are responsible for 

course content and instruction of computer applications courses. Administrators also need to 

provide the necessary support and resources needed by instructors to prepare students for the 

computer skills they will need to be successful at the college level and beyond. 

  Implications for instructors include the importance of assessing the proficiency of 

incoming students and finding the best way to address individualized needs of students. Students 

are arriving on campuses with varied levels of computer proficiency. It is the responsibility of 

instructors to know what skills are necessary for future college and job success and to provide 

instruction to all students. Based on the number of students and the availability of resources, 

instructors should consider various ways of providing instruction and tailor instruction to meet 

students’ needs. The literature review in this study covered various ways of addressing students’ 

computer training needs: self-paced online learning, semester-based online courses, lab-based 

instruction, traditional instructor-led classes, and computer placement exams. Instructors need to 

work closely with administrators to provide a successful learning environment for all students. 

Additionally, findings from this study can be used to encourage colleges and universities 

to assess computer proficiency of students prior to graduation to ensure students have the 

necessary computing skills to be successful in the business environment. This could be 
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accomplished by providing, or requiring, computer certification opportunities to students about 

to graduate and enter the workforce. Certifications such as the Microsoft Certified Application 

Specialist (MCAS) or the International Computer Driving License (ICDL) may work well for 

such a situation. By certifying students just before entering the work force, students can be 

certified in the most up-to-date applications and be able to add the certifications to their resumes, 

which may help make them more marketable as they enter the job market.  

It is important for instructors to remember that even though computer self-efficacy did 

not predict computer performance in this study, computer self-efficacy is still an important factor 

to consider when assessing students. The current study only looked at computer self-efficacy in 

relation to performance; however, computer self-efficacy may be related to motivation to want to 

use a computer and to one’s willingness to choose to use technology, as other studies have 

suggested. These may be beneficial things to consider during the instructional process. 

  Findings from this study challenge administrators in secondary education to unify and to 

begin eliminating discrepancies in technology instruction. Ideally, technology curriculum, 

technology course requirements, and technology graduation requirements should be consistent 

for all high schools nationally. Additionally, administrators need to continually assess the 

computing needs at the college level and in the work force and strive to change curriculum at the 

secondary level as computing needs change.  

Limitations 

Although some findings in this study may be easily generalized, no study is without its 

limitations. The following were identifiable limitations of this study: 

1. The study was limited to multiple sections of one course, at one university. 
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2. The pre- and postcourse surveys were original surveys designed according to specific 

course curriculum and proficiency definitions of one introductory computer course at 

one university. 

3. All participants did not complete all pre- and postcourse proficiency exams, so 

pairwise numbers are not equal across topic areas. 

4. Only one type of training and assessment, which was a competency-based training 

product, was used in the courses for this study. Alternate methods of instruction and 

assessment may have produced other results. 

5. Students previously trained in Office 2003 applications may have overrated their 

ability to complete tasks using Office 2007 software. The user interface of Office 

2007 is quite different from that of Office 2003. New learning needs to take place in 

the transition from Office 2003 to Office 2007, and some participants may not have 

been aware of the differences. 

Recommendations for Future Research 

Technology lends itself to many areas of future research studies. However, based on 

information presented in this study, recommendations for future research are as follow: 

1. A competency-based training product was used for training and assessment in the 

courses utilized in this study. Because competency-based training products for Office 

applications are being used on many college campuses still offering introductory 

computer courses (Cengage Learning, 2008; McGraw-Hill Higher Education, 2007), 

it would be valuable to gather research comparing the various training products for 

computer self-efficacy and computer proficiency gains to determine which of these 

products is the most effective. 
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2. Due to the 120-Hour rule (THECB, 2009), some colleges and universities have done 

away with introductory computer course requirements. Future research should study 

the computer self-efficacy and computer proficiency of students at institutions that 

have discontinued introductory computer courses to see if ratings and scores differ 

from those of students who attended an institution that still offered introductory 

computer courses. 

3. Findings from this study indicated that taking an introductory computer course 

increased both TSCE and computer proficiency. Future research could compare 

computer self-efficacy and proficiency gains of students who test out of introductory 

computer classes to those of students who take introductory computer classes. 

4. Preparation for one’s future profession is one of the main purposes of higher 

education. Surveying recent college graduates, new to the workforce, to collect their 

opinions regarding their preparedness for the computing demands of their workplace 

also warrants further study. Information collected could be used to support changes to 

both college and secondary technology instruction. 

5. Many discrepancies exist when it comes to mandatory technology training in our 

nation’s secondary schools (Ceccucci, 2006; Henke, 2007). Research needs to 

continue to follow changing technology standards and policies at the national, state, 

and local level.  

Conclusions 

Although numerous students are arriving on campus with heightened levels of computer 

self-efficacy, confidence in computing abilities is not transferring to computing proficiency. 

Some students are not computer proficient when they arrive on campus, despite previous cultural 
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technology use and exposure. Results from this study indicate college-age students lack many 

computing skills identified as essential at the college level. Data analysis shows that computer 

self-efficacy ratings and proficiency scores increased after completing an introductory computer 

class.  Findings should be used to support the necessity of introductory computer course 

offerings at the post-secondary level. Additionally, technology instructors at both the secondary 

and postsecondary level need to assess the proficiency of incoming students and provide 

individualized training and assessment to provide students with the computing skills identified as 

essential to be successful in college and beyond.  
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APPENDIX A 

MICROSOFT CERTIFIED APPLICATION SPECIALIST SKILLS 

MCAS Vista Skills 

Protecting Your Computer 

• Manage Windows Firewall. 
• Manage malicious software (also called malware) protection. 
• Configure Windows Update settings. 
• Lock a computer. 
• Mange Window Internet Explorer security. 
• Configure local user accounts 

 
Managing Mobile and Remote Computing 

• Mange the computer power state. 
• Manage network connections. 
• Manage remote access to your computer. 
• Connect to another computer. 
• Access files stored in shared network folders when your computer is offline. 

 
Managing Software, Disks, and Devices 

• Manage software. 
• Mange disks 
• Manage devices and drivers. 
• Mange display settings. 
• Configure multiple monitors. 
• Install and configure a printer 

 
Managing Files and Folders 

• Manage Windows Explorer settings. 
• Manage and secure folders. 
• Share folders. 
• Search for files and folders. 
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Collaborating with Other People 

• Collaborate in real time. 
• Present information to an audience. 

 
Customizing Your Windows Vista Experience 

• Customize and modify the Start menu. 
• Customize the taskbar. 
• Personalize the appearance and sound of a computer. 
• Manage the Windows Sidebar. 

 
Optimizing and Troubleshooting Your Computer 

• Increase processing speed. 
• Locate troubleshooting information. 
• Locate troubleshooting information. 
• Repair a network connection. 
• Recover from software errors. 
• Troubleshoot printing errors. 
• Recover the operating system from a problem 
• Request and manage Remote Assistance. 

MCAS Access Skills 

Structuring a Database 

• Define data needs and types. 
• Define and print table relationships. 
• Add, set, change, or remove primary keys. 
• Split databases. 

 
Creating and Formatting Database Elements 

• Create databases. 
• Create tables. 
• Modify tables. 
• Create fields and modify field properties. 
• Create forms. 
• Create reports. 
• Modify the design of reports and forms. 
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Entering and Modifying Data 

• Enter, edit, and delete records. 
• Navigate among records. 
• Find and replace data. 
• Attach documents to and detach from records. 
• Import data. 

 
Creating and Modifying Queries 

• Create queries. 
• Modify queries. 

 
Presenting and Sharing Data 

• Sort data. 
• Filter data. 
• Create and modify charts. 
• Export data. 
• Save database objects as other file types. 
• Print database objects. 

 
Managing and Maintaining Databases 

• Perform routine database operations. 
• Manage databases. 

 

MCAS Excel Skills 

Creating and Manipulating Data 

• Insert data by using AutoFill. 
• Ensure data integrity. 
• Modify cell contents and formats. 
• Change worksheet views. 
• Manage worksheets. 

 
Formatting Data and Content 

• Format worksheets. 
• Insert and modify rows and columns. 
• Format cells and cell content. 
• Format data as a table. 
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Creating and Modifying Formulas 

• Reference data in formulas. 
• Summarize data by using a formula. 
• Summarize data by using subtotals. 
• Conditionally summarize data by using a formula. 
• Look up data by using a formula. 
• Use conditional logic in a formula. 
• Format or modify text by using formulas. 
• Display and print formulas. 

 
Presenting Data Visually 

• Create and format charts. 
• Modify charts. 
• Apply conditional formatting. 
• Insert and modify illustrations.  
• Outline data 
• Sort and filter data. 

 
Collaborating on and Securing Data 

• Manage changes to workbooks. 
• Protect and share workbooks. 
• Prepare workbooks for distribution. 
• Save workbooks. 
• Set print options for printing data, worksheets, and workbooks. 

 
MCAS PowerPoint Skills 

Creating and Formatting Presentations 

• Create new presentations. 
• Customize slide masters. 
• Add elements to slide masters. 
• Create and change presentation elements. 
• Arrange slides. 

 
Creating and Formatting Slide Content 

• Insert and format text boxes 
• Manipulate text 
• Add and link existing content to presentations. 
• Apply, customize, modify, and remove animations. 
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Working with Visual Content 

• Create SmartArt diagrams 
• Modify SmartArt diagrams. 
• Insert illustrations and shapes. 
• Modify illustrations. 
• Arrange illustrations and other content. 
• Insert and modify charts. 
• Insert and modify tables. 

 
Collaborating on and Delivering Presentations 

• Review presentations. 
• Protect presentations. 
• Secure and share presentations. 
• Prepare printed materials. 
• Prepare for and rehearse presentation delivery. 

 

MCAS Word Skills 

Creating and Customizing Documents 

• Create and format documents. 
• Lay out documents. 
• Make documents and content easier to find. 
• Personalize Office Word 2007. 

 
Formatting Content 

• Format text and paragraphs. 
• Manipulate text. 
• Control pagination. 

 
Working with Visual Content 

• Insert illustrations. 
• Format illustrations. 
• Format text graphically. 
• Insert and modify text boxes. 
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Organizing Content 

• Structure content by using Quick Parts. 
• Use tables and lists to organize content. 
• Modify tables. 
• Insert and format references and captions. 
• Merge documents and data sources. 

 
Reviewing Documents 

• Navigate documents. 
• Compare and merge document versions. 
• Manage tracked changes. 
• Insert, modify, and delete comments. 

 
Sharing and Securing Content 

• Prepare documents for sharing. 
• Control document access. 
• Attach digital signatures. 
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APPENDIX B 

PRE- & POSTCOURSE PROFICIENCY EXAM 

Windows 
Vista Display the Sidebar. 

Click the Start button and select All Programs. 
Click Accessories and select Windows 
Sidebar. 

Windows 
Vista 

Launch the program that will 
let you connect to another 
computer remotely. 

Click the Start button. Click All Programs. 
Click Accessories. Click Remote Desktop 
Connection. 

Windows 
Vista 

Open the Backup Status and 
Configuration window and 
scan for new or updated files to 
add to the backup for this 
computer. 

Click the Start button. Click All Programs. 
Click Accessories. Click System Tools, and 
select Backup Status and Configuration . 
Click the Back up now . 

Windows 
Vista 

Create a new folder named 
Letters in the current location. 

Click the Organize button on the Command 
Bar. Click New Folder. Type Letters. Press 
Enter. 

Windows 
Vista 

Open the Help and Support 
Center. 

Click the Start menu and select Help and 
Support. 

Windows 
Vista 

Create a new standard user 
account with the name Ben 
Delbow. 

Click the Start button and select Control 
Panel. Under the User Accounts category, click 
the Add or remove user accounts link. Click 
Continue. Click Create a new account. Type 
Ben Delbow. Click Create Account. 

Windows 
Vista 

Change the screen resolution to 
be 1280 by 1024 pixels. 

Click the Start button and select Control 
Panel. Click the Adjust screen resolution link. 
Click the Screen resolution slider and drag 
towards high until it reads 1280 by 1024 pixels. 
Click OK. 

Windows 
Vista 

Change the status of the 
Windows Firewall to the 
recommended setting. 

Click the Start button and select Control 
Panel. Click the Security category. Click the 
Turn Windows Firewall on or off link under 
the Windows Firewall category. Click Continue 
in the User Account Control dialog box to 
continue. In the Windows Firewall Settings 
dialog box, click the On (recommended) radio 
button. Click OK. 



 

94 

Windows 
Vista 

Disconnect from the wireless 
network you are connected to. 

Click the Windows Start button, and click 
Connect To. Click the Disconnect button. 
Click the large Disconnect button to confirm 
that you want to disconnect from this network. 
Click Close. 

Windows 
Vista 

Change the desktop 
background to use the dark 
blue solid color (the first image 
in the second row of the Solid 
Colors location). 

Click the Start button and select Control 
Panel. Click the Change desktop background 
link. Open the Picture Location menu and 
select Solid Colors. Click the dark blue square 
(the first image in the second row) image to 
select it. Click OK. 

Access 
2007 

Create a new blank database 
named Accounting. 

Click the Office Button. Click New. Type 
Accounting in the File Name: box. Click 
Create. 

Access 
2007 

Create a new table in Design 
view. 

Click the Table Design button in the Tables 
group on the Create tab. 

Access 
2007 

Create a new blank form 
directly in Design view. 

Click the Create tab. Click the Form Design 
button in the Forms group. 

Access 
2007 

Create a back up copy of this 
database. Accept the suggested 
filename, and do not change 
the file location. 

Click the Office Button. Point to Manage, and 
click Back Up Database. Click the Save 
button. 

Access 
2007 

Create an automatic basic 
report based on the Employees 
table. 

Click the Create tab. Click the Report button 
in the Reports group. 

Access 
2007 

Export the Vendors table as a 
Text document named 
vendors.txt. Do not export the 
layout and format. Do not save 
the export. 

Click the External Data tab. Click Text in the 
Export group. Click OK. Click Close. 

Access 
2007 

From Layout view, change the 
orientation of the printed report 
so it is wider than it is tall. 

Click the Page Setup tab. Click the Landscape 
button. 

Access 
2007 

Enforce referential integrity 
between the Deliverables and 
Vendors tables. 

Click the Relationships button in the 
Show/Hide group on the Database Tools tab. 
Double-click the line connecting the 
Deliverables and Vendors tables. Click the 
Enforce Referential Integrity check box. Click 
OK. 
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Access 
2007 

Create a new query in Design 
view. Add the tables 
Deliverables and Employees. 
Add these fields in order: 
Deliverable, Status, and Last 
Name. Run the query. 

Click the Create tab. Click the Query Design 
button in the Other group. Double-click 
Deliverables. Double-click Employees. Click 
Close. Double-click Deliverable. Double-click 
Status. Double-click Last Name. Click the 
Run button in the Results group on the Query 
Tools Design tab. 

Access 
2007 

Add the image file Chur.png 
to the record. The attachment 
field shows a placeholder 
image. 

Double-click the placeholder image. Click 
Add... Click Chur.png, and click Open. Click 
OK. 

Excel 2007 
Enter the number 0.0 in cell 
D9. 

Click the cell in the fourth column, ninth row 
and type 0.0. Press Enter. 

Excel 2007 

Without using Print Preview, 
print the selected sheet, 
ignoring the defined print area. 

Click the Office Button. Point to Print, and 
then click the Print option. Click the Active 
sheet(s) radio button. Click the Ignore print 
area check box. Click the OK button. 

Excel 2007 

Enter a formula in cell A11 to 
display the text from cell A2 
with only the first letter of each 
word in upper case. 

Click the Text button in the Function Library 
group on the Formulas tab. Select PROPER 
from the list. Type A2 in the Text box, and click 
OK. 

Excel 2007 

Create a 3-D Clustered 
Column chart from the selected 
data. (Use the first 3-D column 
option.) 

Click the Column button in the Charts group on 
the Insert tab. Click the first chart type under 3-
D Column. 

Excel 2007 
Switch to the normal Excel 
view. 

Click the View tab, then click the Normal 
button. 

Excel 2007 

Display the formulas in this 
worksheet. Do not change the 
sheet options. 

Click the Show Formulas button from the 
Formula Auditing group in the Formulas tab. 

Excel 2007 

Save this worksheet in a text 
format using tabs to separate 
columns. 

Open the Office Button menu. Point to Save As, 
and click Other Formats. Click the Save as 
type: arrow and select Text (Tab delimited). 
Click Save. 

Excel 2007 

Filter the table by the Cost 
column, so only cells formatted 
with blue text appear. 

Click the AutoFilter arrow at the top of the 
Cost column, point to Filter by Color, and 
click the blue option under Filter by Font 
Color. 

Excel 2007 

Change the orientation of cell 
B5 so it is rotated 45 degrees 
counterclockwise (so the cell 
data slants upwards from left to 
right). 

Click cell B5. In the Alignment group on the 
Home tab, click the Orientation button and 
select Angle Counterclockwise. 
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Excel 2007 

Create a new scenario to reflect 
a change in cell B6 to a value 
of 400,000 Name the scenario 
Max Salaries. Show the 
scenario, and close the 
Scenario Manager. 

Click the What-If Analysis button in the Data 
Tools group on the Data tab, and click Scenario 
Manager... Click the Add... button. Type Max 
Salaries in the Scenario name: box. Type B6 in 
the Changing cells: box. Click OK. Type 
400000 in the text box. Click OK. Click Show. 
Click Close. 

PowerPoint 
2007 

Move the fourth slide so it 
appears above the third slide in 
the presentation. 

Click and drag the fourth slide. When the cursor 
is above the third slide, release the mouse 
button. 

PowerPoint 
2007 

Copy the presentation to a CD 
named Clothing Presentation. 

Click the Office Button. Point to Publish and 
select Package for CD. Type Clothing 
Presentation in the Name the CD: box. Click 
Copy to CD. 

PowerPoint 
2007 

Add a custom animation to the 
image. Have the object fly out 
to the right. 

Click the Animations tab. Click the Custom 
Animation button. Click the Add Effects 
button, point to Exit, and click Fly Out. Click 
the Direction: drop-down arrow and select To 
Right. 

PowerPoint 
2007 

Add the introduction.mp3 file 
to the slide. Have the audio 
play when the slide is clicked. 

Click the Insert tab. In the Media Clips group, 
click the Sound from File button. In the Insert 
Sound dialog box, click the file to select it. 
Click the OK button. Click the When Clicked 
button. 

PowerPoint 
2007 

Switch to the view where you 
can make changes to a master 
slide that will affect slides in 
the entire presentation. 

Click the View tab on the Ribbon. Click the 
Slide Master View button. 

PowerPoint 
2007 

Preview the presentation for 
printing, changing the option to 
display three slides per page. 

Click the Office Button, point to Print, and 
select Print Preview. Click the Print What: 
drop-down list and select Handouts (3 Slides 
Per Page). 

PowerPoint 
2007 

Adjust the image so it had 10% 
more contrast. 

Click the Format tab under Picture Tools. In the 
Adjust group, click the Contrast button and 
select +10 %. 

PowerPoint 
2007 

From the Ribbon, change the 
image so it appears behind all 
the other objects on the slide. 
Do not use the Selection Pane. 

Click the Picture Tools Format tab. In the 
Arrange group, click the Send to Back button. 
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PowerPoint 
2007 

Add a Continuous Picture 
List SmartArt graphic to the 
slide. It is the fourth option in 
the third row in the Choose a 
SmartArt Graphic dialog box. 

Click the Insert tab. Click the Insert SmartArt 
Graphic button. Click the image with the three 
vertical boxes with circles in the third row. 
Click OK. 

PowerPoint 
2007 

Start the feature where you can 
practice the timing of your 
presentation and save the 
settings for playback. 

Click the Slide Show tab. In the Set Up group, 
click the Rehearse Timings button. 

Word 2007 

Use the Document Map to 
navigate to the Management 
Team section of the document. 

Click the View tab. Click the Show/Hide 
button. Click the Document Map check box. 
Click the Management Team heading in the 
Document Map. 

Word 2007 

Add the book Healing 
Through Pressure as a new 
source for a bibliography. The 
author is Sue Chur and the 
book was published in 2004. 

Click the References tab. In the Citations & 
Bibliography group, click the Insert Citation 
button and select Add New Source... Click the 
Type of Source arrow and select Book. Type 
Sue Chur in the Author box. Type Healing 
Through Pressure in the Title box. Type 2004 
in the Year box. Click OK. 

Word 2007 
Hide the formatting changes in 
the document. 

Click the Review tab. Click the Show Markup 
button and select Formatting. 

Word 2007 Create a new blank document. 

Click the Office button and select New. Verify 
that Blank document is selected and click the 
Create button. 

Word 2007 
Insert the rehabilitation.jpg 
file into the document. 

Click the Insert tab. Click the Picture button. 
Click the rehabilitation.jpg file to select it. 
Click the Insert button. 

Word 2007 
Change the bulleted list so it 
uses the open circle style. 

Click the Bullets button arrow and select the 
third style in the first row of the Bullet Library. 

Word 2007 
Change Word's color scheme 
to silver. 

Click the Office button. Click the Word 
Options button. Click the Color scheme: 
arrow and select Silver. Click OK in the Word 
Options dialog box. 

Word 2007 

Hide the tracking for the 
document, showing the final 
version of the document. 

Click the Review tab. In the Tracking group, 
click the Display For Review drop-down arrow 
and select Final. 

Word 2007 
Change the line spacing to one 
and half lines. 

In the Paragraph group on the Home tab, click 
the Line Spacing button arrow and select 1.5. 

Word 2007 Sort the list from A to Z. 
In the Paragraph group on the Home tab of the 
Ribbon, click the Sort button. Click OK. 
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PRECOURSE SURVEY 
 

 



 

99 

 

 

 

 

 



 

100 

 

 



 

101 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

102 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

103 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

104 

 



 

105 

 
 
 
 
 

APPENDIX D 

POSTCOURSE SURVEY 
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APPENDIX E 
 

IRB APPROVAL 
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APPENDIX F 
 

PARTICIPANT INFORMATION SHEET 
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